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| Read This First

B Disclaimer

» While every effort has been made to ensure that the information contained in this
guide is accurate and complete, no liability can be accepted for any errors or
omissions. Canon reserves the right to change the specifications of the hardware
and software described herein at any time without prior notice.

* No part of this guide may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form, by any means,
without the prior written permission of Canon.

» Canon makes no warranties for damages resulting from corrupted or lost data
due to mistaken operation or malfunction of the camcorder, the software, memory
cards (miniSD Cards), personal computers, or peripheral devices, or due to use
of a memory card not initialized by a Canon camcorder.

B Trademark Acknowledgments

» QuickTime is a trademark of Apple Inc., registered in the U.S. and other
countries.

* Microsoft, Windows, and the Windows Vista are trademarks or registered
trademarks of Microsoft Corporation in the United States and/or other countries.

« MiNi is a trademark of SD Card Association.

» Other names and products not mentioned above may be registered trademarks
or trademarks of their respective companies.

© Canon Inc. 2007 All rights reserved.

B Safety Precautions

Do not play the supplied CD-ROM(s) in any CD player that does not support data
CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could

damage the speakers. It is also possible to suffer from hearing loss from listening
with headphones to the loud sounds of a CD-ROM played on a music CD player.

Checking Supplied Accessories

Use the following accessories to download recorded still images from a memory card
to your computer.

* IFC-300PCU USB Cable * DIGITAL VIDEO Solution Disk

The explanations in this manual use mainly Windows XP screen shots. The steps
and windows may vary depending on your computer and the version of software.
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| System Requirements

Install the software on a computer meeting the following minimum requirements.

0OsS: Windows Vista
Windows XP Home Edition or Professional
(Service Pack 1 or 2)
Windows 2000 (Service Pack 4)
* Proper operation is not guaranteed on an OS that has
been upgraded from a previous version.

Computer Model: Computers that come with above OS preinstalled and
have built-in USB ports.
CPU: Windows Vista: Pentium 1.3 GHz or better
Windows XP/Windows 2000: Pentium 500 MHz or better
RAM: Windows Vista: 512 MB or more
Windows XP/Windows 2000: 256 MB or more
Interface: USB: only preinstalled Windows Vista/Windows XP/

Windows 2000 systems with built-in USB ports

Free Hard Disk Space: < Canon Utilities
- ZoomBrowser EX: 200 MB or more
* Canon DV TWAIN Driver: 25 MB or more

Display: 1024 x 768 pixels or better/High Color (16 bit) or better

VG‘ O Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.
\X¥] o Proper operation is not guaranteed on any particular system, even if it meets
the requirements outlined above.
O A CD-ROM drive is required to install the software.

In this Instruction Manual, product names are abbreviated as follows:

Microsoft Windows Vista: Windows Vista
Microsoft Windows XP Home Edition or Professional

(Service Pack 1 or 2): Windows XP
Microsoft Windows 2000 (Service Pack 4): Windows 2000

System Requirements I 5



| What is Digital Video Software?

The following software will be installed by installing the Digital Video Software.

B ZoomBrowser EX

* Viewing downloaded still images

 Categorizing, organizing, and searching large volumes of still images
« Editing still images

« Changing the data for still images and save them as new files

* Viewing still images in a slide show

» Adding sound to a still image

B CameraWindow

* Downloading still images from a memory card to your computer

* Viewing still images recorded on a memory card

* Printing still images recorded on a memory card without downloading the still
images to the computer

B TWAIN Driver (Windows 2000 only)

* Driver software that enables you to download still images from a memory card to
a computer.

This instruction manual explains how to install the software, what you can do with the

main features and how to operate them. For more detailed operational instructions,
refer to the Help menu of each software program.
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| Windows

CameraWindow

CameraWindow is a program created to download still images from the memory card
to the computer. Furthermore, you can print still images recorded on the memory card
without having the images downloaded to the computer ([ 1] 39), and you can confirm
and change the owner’s name of the camcorder you specify ([1] 83). Refer to Starting
CameraWindow ([1] 28) for launching the software. The Remote capture function is
not supported by the camcorder.

B [Acquire Images] Tab

This tab is used for downloading still images recorded on the memory card by
connecting a camcorder or a card reader/writer to the computer.

Camera Control window

¢ CameraWindow - Canon -E ko

Selects a function in the Camera _" Acouire Images | Print || Set to Camera | Remote shooting '

Control window.

Downloads uzing camera

PP CU&N| FPress the camera's button
P

Images will be downloaded to -
the computer, and ZoomBrowser EX | T

starts. [
% Starts to download images
Images in the camcorder are —L ol
displayed allowing you to select 1 S [|i8ts you select and dgsmload images
images.
PIaCing a check mark here makes e /| Digplays this soreen when the camera is connected

the Camera Control window to open

automatically the next time you Preferences..

connect the camcorder.

Specify the image type to be downloaded and
the destination folder.
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W [Print] Tab
This tab is used for printing still images on the memory card without having the images

downloaded to the computer. The window varies depending on the selected printing
type. Refer to Printing Still Images Recorded on the Memory Card ([ 1] 39).

Camera Control window

Prints all still images in the card —
one image per page.

_Acquirelmage& Frint | Set to Camera | Femote shooting

. L . fas) Print All Photos
Prints all still images in the card —

as an index page (rows of images

with file names and image | =51®!| Print Contact Sheet with All Photos
information). 22

settings set by the camcorder to the

Prints according to the DPOF print ——l ™ | Printaccording to DPOF setlings
still images recorded on the card. ——

S Select an image and print

Displays a list of the still images —
in the card, allowing you to select _ _ :

. . Dizplays thiz gcreen when the camera iz connected
which ones to print. -
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B [Set to Camera] Tab

This tab is used for confirming and changing the owner’s name of the camcorder you
can specify ([] 83) and uploading the still images to the card. My Camera function is
not supported by the camcorder.

& CameraWindow - Canon 4+ %

| Acauire Images | Print | Setto Camera | Remate shooting

Camera Control window

Set My Camera

Confirms/changes camera settings

Enter or change the name of
the camcorder’s owner.

EEE
&

Uploading the images from the _|'j§_lu Uploads images to the camera
computer
Digplays thiz screen when the camera iz connected
2Py Selecting [Manage My Camera] from the [Edit] menu displays the [My Camera]

4 window. If you click [Creating My Camera data] in the [My Camera] window,
[My Camera Maker] will be launched. [My Camera Maker] is a program that
enables you to create and import My Camera contents (start-up images, start-
up sound, shutter sound, operation sound and self timer sound) to camcorders
that support this function. Your camcorder does not support the My Camera
function.
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B Camera Browser Window

IMG_0101JPG

FileiF) Edit(E) Wiewi¥) H

e' CameralWindow - Ca
piH)

'—‘Jlmage Download [' dPr\nt il @Start ZoomBrowser EX

IMG_0102.PG IMG_0103.PG

Se

IMG_0104.PG

Prints the selected still images.

Starts ZoomBrowser EX.

_# | File Informati
File Mame:  IMG_0101.JPG
Modified:  200%/01/1574:45:2

Ion;

File Size: 20KR
Image Size:  E40x480

# | Histogram:

Selects the still image selection method.

Changes the size of the thumbnail.

Photo Effect

| # | Details:
Ttem Mame Value A
File Mame IMG_010
Camera Model M., Canon
Shoating Date)Ti... 1f15/200
Shoating Mode Partrait

Off

T (Shutter Speed) 140

Ay (Aperture val... 2.0

Light Metering Evaluativ

Exposure Comp.,, 0O

150 Speed Auko

Lens 2.6- 851

Focal Length 7.9 mm

Digital Zoom Mone

Image Size E40:430

Image Quality Fine v
4l | \. $ J >/_J

Selects ima 1 of 4

Selects whether to show or hide the image

frame and file name.

Still image information and a histogram
(This will not be displayed when using a card reader/writer.)

=

still images (4:3).

&8 GameraWindow - Canon * -
File{Fy Edit{E} Wiew™) Help{H)

I Windows

IMG_0101.JPG IMG_0102.JPG

IMG_0103.JPG

-—f-"_‘ El B —
& Image Download ['“#\B Print = ﬁﬂ:art ZoomBrowser EX

B, Select ~ =l

JF— =

@

If your camcorder supports wide size still image (16:9 such as 1920 x 1080
pixels) recording, the thumbnails that appear in this window will be also 16:9
images. The sample images used on this instruction manual are normal size



Main Window

ZoomBrowser EX is a software program used for organizing, printing and editing the

downloaded still images. If you wish to start ZoomBrowser EX without connecting the

camcorder or card reader/writer, double-click the

on the desktop, or click the

ZoomBrowser
Ex

Windows [start] menu and select [All Programs] » [Canon Utilities] » [ZoomBrowser
EX] and [ZoomBrowser EX]. To exit ZoomBrowser EX, click £ or select [Exit] from

the [File] menu.

T ZoomBrowser, BX - C:\Documents and SettingsiCanoniMy Documentsity Pictures | g@
File Edit View Tools Internet Help
[ rask: [~} [ C‘:,jji Siide Shaw ‘Q Search ]
P fz Mod } 5
I[I@ Acquite & Camera Settings oor Mode | Scroll Mode | Preview Mode| f — .
= lMy Pictures 4 H-0-|| & ® e [ FiterTeol )
1 — View & Classify
) \'+] 200%_01_15
Edit
@ Expart 4
@_ Fiint
&
Qs Intermst
L J
 Farvorits Folders _AH Fomerg_ \
Last Acguired Images
2 e | ) [Z]] All Images
= % shooting Date < IMG_0103.0PG  IMG_0104| M
JE] zo0% 01 15
Favorite Folders
=F[9 My Pictures
¥ zo0x_01_15 -~ 3
() 2005_01_20
3| Search Resuls
| ‘ | A |
| MG_0109.0PG  MYL0106. 44
( Add.. |[[ Remove |
\. J T
Selected Ttems: 0

[Acquire & Camera Settings]:

[View & Classify]:
[Edit]:
[Export]:

[Print]:
[Internet]:

Use this to display the Camera Control window to
download still images, to print still images without
having them downloaded to the computer and to
configure the camcorder settings.

Use this to view and organize still images.

Use this to edit still images.

Use this to change the data for still images and
save them as new files, extract still images from
movies, back up to CD-R/RW (Windows Vista/
Windows XP), or export shooting properties to a
text file.

Use this to print downloaded still images.

Use this to attach selected still images to e-mail
messages.
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Folders Area

You can select a folder to be displayed in the Browser Area. In the [Last Acquired
Images] panel, the newly downloaded still images are placed into virtual folders
classified by recording date. In the panel below, the folders where the downloaded
still images are actually saved in are displayed. Selecting the [Favorite Folders] tab
shows only the folders that are registered as favorites. The [All Folders] tab shows all
available folders. l. indicates that newly downloaded still images are in the folder.
To register folders as Favorites, follow the instructions below.

When the [Favorite Folders] tab is selected:
Click [Add] and select a folder.

When the [All Folders] tab is selected:
Select a folder and click [Add to Favorites].

To remove the registered folder, select the folder, and click [Remove].

Browser Area

This area displays the images contained in the selected folder. If you place the
cursor over a thumbnail in the browser area, will be displayed at the upper right
corner. Clicking skips over folders to zoom in directly on the intended folder.

2Py © Clicking on 2 images while holding down the [Shift] key selects also all

&

images between the 2 images.
o Clicking on different images while holding down the [Ctrl] key selects multiple

images.
4 Browser Area Tool Bar
The menu items vary depending on the View Mode.
1 2 3 4 5 6 7 8
L || g [ — |
-0 h & QAT [0, | | | | Fiter Tool |
1 | Previous/Next Displays the previous/next image in the current folder.
2 |Up Displays the folder in the upper tiers of the hierarchy.
3 | Select Allows you to select all images and deselects images.
4 | Information Allows you to select the information to be shown. You can
also hide the pop-up window by clearing the check box.
The pop-up window appears when you move the pointer
over a thumbnail.
5 | Pan Changes the area displayed when you zoom in on a folder

or image in the Browser Area and drags the thumbnail list.

Restore Display Size | Changes the size of the thumbnail list to fit the window.

Zoom Slider Enlarges/Reduces the thumbnails in the Browser Area.

Filter Tool Allows you to select which still images to display
according to the star rating. When you download the
images, the star rating is set to two stars as a default. To
change the star rating, refer to Applying Star Ratings and
Keywords ([]]48).

Windows




5 View Mode
You can select the view mode of images in the Browser Area.
[Zoom Mode]: The images in the selected folder are shown as thumbnails.

Zoom Mode | Serol Mode | Preview Modz |

My Pictures €2 |H-0-A& et [ 5 Fiter Toul ]‘
|

3] 200%_01_15

MG_0101.0PG  IMG_0102.1PG

IMG_0103.0PG  IMG_0104.JPG

[Scroll Mode]: Thumbnails of the images are displayed next to the folder name.
Clicking a folder displays enlarged images. Selecting [Preferences] from the
[Tools] menu opens the [Preferences] window, on which you can select the
hierarchy of folders. In the screenshot below, [Maximum scroll mode folder
depth] (hierarchy of folders) is set to two.

ZoomMode | SerollMade | Freview Mode

My Pituies €32 H-0- [
5 2o o115 36158 - IRy
ez PRI B

[Preview Mode]: Double clicking the folders at the bottom of the window opens the
folder and shows a large still image in the folder along with detailed information.
You can change file name and comments. To display another image, click
[Previous]/[Next] or select an image shown at the bottom of the window.

| Zoom Mode | Seroll Mode | Preview Mode |

200%_01_16 € + - 0- [ &FFieTe
r | File Infarmatian: A
Fie Mame;  [IMG_D101

Modifiedt 1AS/200% [ Protect
File Size 228KE

Image Size: 640 % 460

DataTyps:  JPR

AT AR
[¥] Comment:
i [¥] Keywards:
[&] Brightriess Histogram:

PN

I 0

| [&] Shacting Infarmation:

Itemn Name: Walue
File: Name IMG_0101.JPG

Camera Model Mame  Canon skooksok
Shonoting Date/Time  1/15/200 5 25:50 & s
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6 Application Tool Bar

1

2

3

4 5 6

. | |
|E Yigw Image Properties |D§ Slide Shaw @ Search ﬁ Delete E_:QJ Rakate

View Image Displays a selected image in the [Image Viewer] window.

2 | Properties Displays properties of the selected still image. When you
select a different image while the [Properties] window is
open, the information switches to the one of the selected
image. The [Properties] window cannot be displayed in

[Preview Mode].

o Properties
Modified: 1/15/2005
File Size: 828KB
- Image Size: B40 » 480
:‘ Data Type: JPG
Sound
Wiew Image.

Pathe  C:\Documents and Settings\CanonbMy Docy
=] File Name:
IMG_001
[&] Star Rating
. [] Protect

[&] Comment:

[F] Kepwords
View/Modily Keywerde ..

[&] Brightness Histogram:

(2] Shooting Information:

Item Name Walug o |

File Name

Shaoting Mods
Photo Effect

Camera Model Name  C.
Shooting Date/Time

IMG_0101.JPG

anon KKKk
1/15/200%2:43:28 PM
Portrait

o
Tw (Shutter Spesd] 1440
by (Bnethue Waliel 21 L]

< Previous 5
3 | Slide Show Displays still images in a slide show.
4 | Search Allows you to search for images ([ ] 53).
5 | Delete Deletes selected images.
6 | Rotate Rotates selected still images. A movie cannot be rotated.
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[Image Viewer] Window

The [Image Viewer] window appears when you select an image and click [View Image]
or double-click an image.

10 =
11 =
12 -
13
14
15 =

2 34 5 67 8 9
|@|M||M ||

= 1= [0 )| @Rl smven=

L) | & | B e -

Zoorn Ratio: 100%

Previous/Next

Displays the previous/next image in the current folder.

Zoom In/Zoom Out

Enlarges/Reduces a still image.

Pan

When the image is larger than the window, you can move
the image in the desired direction.

Print

Prints the selected still image. Refer to [One Photo per
Page Print] ([I] 44).

Edit

Allows you to perform the following operations: red-eye
correction, auto correct, color and brightness correction,
sharpness adjustment, trimming, inserting text, or
registering external image editing applications.

Auto Focus Frame

This function cannot be used for the images recorded by
the camcorder.

7 | Shooting The shooting information of the image will be displayed.
Information
Show Allows you to display multiple images at the same time.
Synchronize Synchronizes the View functions across all displayed
images.
10 | Fit to Window Matches the image size to the size of the Image Viewer
Window.
11 | Restore Restores the standard display size.
12 | Zoom Slider Allows you to enlarge/reduce the displayed image.
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13 | Show Image Full
Screen

Displays an image in full screen size.

14 | Change the Star
Rating

Allows you to change the star rating.

15 | Capturing Frames

Extracts still images from movies.
(Windows Vista/Windows XP)

2Py Windows Vista: The star rating set using ZoomBrowser EX is not related to the
&z “Rating” setting in Windows Photo Gallery and Windows Explorer.

B [Red Eye Correction] Window
Select [Red Eye Correction] from the [Edit] menu, or click the [ - icon and
select [Red Eye Correction]. Use this to correct still images in which people’s eyes

appear red.
IS Red Eye Correction - CrDucuments and Sellings\Canoniy Documents\200%_01_15UNG_.... |- D)%)
1
2
[T 5hew Original Imags
®) @ QO E — f—
Auto Mode Clicking [Start] corrects the red eye effect automatically.

2 | Manual Mode

Point the cursor on a red eye so that the area is
highlighted green, and click the mouse button.

16 I Windows




B [Auto Adjustment] Window

Select [Auto Adjustment] from the [Edit] menu, or click the e - icon and select

[Auto Adjustment]. Use this to automatically correct the color balance of the still

image.

ORIy

Auto Adjustment - C:\Documents and| SettingsiCanoniy Documentsi200X_01_15MMG_01... |:‘E||z‘

Auto Adjust Image

[Color/Brightness Adjustment] Window
Select [Color/Brightness Adjustment] from the [Edit] menu, or click the [t - icon

and select [Color/Brightness Adjustment]. Use this to adjust the brightness,
saturation, contrast, intensity levels, tone curve and RGB of the still image.

Please select adjustment option:
Caolor Adjustrent @
Brihinesss ——— | |°_ &)
Saturat —J 0 &
Cantrast J 0 Gl
Undo &1 Undo
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B [Sharpness] Window
Select [Sharpness] from the [Edit] menu, or click the e~ icon and select
[Sharpness]. Use this to emphasize and clarify the outlines of people and objects.

(= Sharpness - C:3Documents and SettingsiCanoniMy Documentst200X_01.154MG 0104, PG |:E||Z‘

Sharpen Unisharp Mask |
fanount: || L=
@ Q M|

B [Trim Image] Window
Select [Trim] from the [Edit] menu, or click the &=t - icon and select [Trim]. Either
drag the pointer on the still image or specify the cropping area, and click [Trim
Image].

=] Trim Image - C:\Documents and Settings\Canoniy Documents\200X_01_15MMG_0103.JPG ‘E@

M&ettlngs:
Location [topleft comer)
e Z
v |0
, Size of kimming area:
w [0

H[o

(]| GRE |, e

Cancel
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B [Insert Text] Window

Select [Insert Text] from the [Edit] menu, or click the &=t - icon and select [Insert
Text]. Use this to write text on still images.

— =
Insert Text - C:\Documents and Settings\Canoniby Documentsh200X_01_15\MMG_0104. JPG |7‘E”§‘
Insert Text:
Font Name: _ o)

Font Size 8 &

Text Color (|

Text Attribute; B 7 O
Antialias

Text:

«<Select the location on the image first, then
tupe pour text in heres

(TR & € 1 L

These image correction tools can be selected by clicking [Edit] » [Edit Image]
in Task Area of the Main Window.
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| Installing the Digital Video Software

@ O Be sure to install the Digital Video Software before connecting the
¥ camcorder to the computer.
O You must have authorization as a Computer System Administrator to install
programs.

Windows Vista/Windows XP Users:

Your digital video camcorder is equipped with the standard Picture Transfer

Protocol (PTP). This protocol enables you to download still images by simply

connecting the camcorder to a computer with the USB cable (applications such

as the [Scanner and Camera Wizard] start automatically).

However, note that there are several limitations to downloading still images

with this method. To avoid these, install ZoomBrowser EX to download still

images.

0 It may take a few minutes, after connecting the camcorder, until you can
download still images.

o Still images protected on the camcorder may lose this setting once they are
downloaded to the computer.

1 Check that the camcorder is not connected to the computer.
While a camcorder is connected to the computer, the software cannot be
installed normally. If a camcorder is connected, detach the USB cable from the
computer.

2 Set the DIGITAL VIDEO Solution Disk in the computer’s CD-
ROM drive.

* Windows Vista: When the [AutoPlay] window appears, click [Run
SETUP.EXE]. Follow the instructions in the [User Account Control] window
that appears after a brief period.

* Windows XP/Windows 2000: The installer panel appears automatically.

« If the installer panel does not open automatically, use the following procedures
to display it.

- Windows Vista:
1) Select [Computer] from the Start menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [setup.exe] icon.
4) Follow the instructions in the [User Account Control] window that
appears.
- Windows XP:
1) Select [My Computer] from the [start] menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [SETUP.EXE] icon.
- Windows 2000:
1) Double-click the [My Computer] icon.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [SETUP.EXE] icon.
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Depending on your computer’s settings, the file extension “.EXE” may not
appear.

Select your country or region.
Select your language.

Click [Easy Installation] under Digital Video Software.

To install the software individually, click [Custom Installation].

Installer Panel —— Canon DIGITALVlDEO
Solution Disk

Digital wideo Software

Y
Easy Installation /\

Automaticaly inskalls al softwars.

=
Custom Installation |

Select the software that you want toinstall,

( Install >|

QuickTime

Exit

If other software is running, close all programs and click
[OK].

Start installing Digital Wideo Solution Disk,
Close any other open applications and click [Ok].
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T Review the installation settings and click [Install].
If you selected [Custom Installation] and are using Windows 2000, select Canon
DV TWAIN Driver (USB driver).
OOOOOO o t@ ZoomBerowser EX 165 MB
EEEEEE &I EOS Utility 20 MB

Wiew a description of the software by passing your mouse over the name of the
;;;;;;;

N
=

C:\Program Files\Canont,

Click [Install] to start installing.

¢ ‘ Back |

oy When installing the software on Windows XP or 2000 by selecting [Easy

<d |nstallation], EOS Utility (software for downloading still images from the Canon
EOS Digital SLR Cameras) will be installed. This software is used only for
compatible Canon EOS Digital SLR Cameras, and the camcorder does not
support this software.
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Read the license agreement and click [Yes] to accept the
terms and to start installation.

License Agreement

Please read the following License Agreement carefully before installing the
saftware.

License IMPORTANT MOTICE

This software conkains the Adobe color profiles (Adobe REE(1998), Anple REE,
ColorMatch RGB, Wide Gamuk RGE),and which are licensed under the Folloing

step 3 Installation Adobe SYSTEMS INCORPORATED COLOR PROFILE LICENSE AGREEMENT, This
software other than such Adobe color profiles is licensed under the Following
Canon Software License Agreement .

stepd  Finish - -
CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ CAREFULLY BEFORE INSTALLING THE SOFTWARE! This
dacument is @ legal agreement (*Agreement”) between you and Canen Inc,
{'Canon') and goverring your se of this software, and online manual or other
electranic documentation, and sound data and image deta, it any (the "Softwars").
BY IMSTALLING THE SOFTWARE, YOU AGREE TO BE BOUNMD BY THE TERMS OF
THIS AGREEMEMT. IF ¥OU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,
PROMPTLY STOR THE INSTALLATION PROCESS,

1. GRAMT OF LICENSE

(1) Canon grants you a non-exclusive license o use ("use” shall mean storing,
Inading, instaling, executing, or displaying) the Software on your computers solely

for Use with Canon product. You may allow other users of Canon's product touse v

Click [Yes] to accept the License Agreement. If you click [Mo], the installation
of Digital Video Solution Disk wil be canceled.

Click [Next].

| m [ ZoomBrowiser EX
Installed
m R EOS Utility
Installed

Installation

of ZoomBrowser EX

o ECS Utility

stepd  Finish

Installation has completed
successfully.

Leaving the CD in.the drive, proceed
to the next step.
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10 When the installation is complete, select [Restart computer
immediately (Recommended)] and click [Restart].

Installation of the software has been completed.

( Restart computer immediately (Recnmmended))

29y When you do not need to restart the computer, the [Finish] screen will be
& displayed. Click [Finish]; remove the DIGITAL VIDEO Solution Disk from the
CD-ROM drive, and proceed to Before Downloading Still Images ([ 1] 25).

11 When the computer has restarted and the regular desktop
screen is displayed, remove the DIGITAL VIDEO Solution
Disk from the CD-ROM drive.

When installation is complete, remove the DIGITAL VIDEO Solution Disk before
you connect the camcorder to the computer.

oy Windows 2000: At this point, the files for the TWAIN Driver have only been

# copied to your computer. To download images via USB connection, finish
installing the TWAIN Driver. For details, see step 5 ([I] 25) in Connecting the
Camcorder to a Computer.
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| Before Downloading Still Images

Connecting the Camcorder to a Computer

VG‘ O Be sure to install the Digital Video Software before you connect the
\ o /| camcorder to the computer.

O Make sure the camcorder is being powered using the power adapter before
connecting it to a computer.

o Connect the USB cable directly to one of the computer’s main USB ports.
The interface may not function correctly if the camcorder is connected via a
USB hub.

O The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this occurs,
disconnect the other devices from the computer and try reconnecting the
camcorder.

O Do not connect two or more camcorders to the computer. The camcorders
may not operate normally.

O Never allow the computer to go into standby (sleep) mode while a
camcorder is connected via the USB interface.

2Py O Referto your computer manual for the location of the computer’'s USB ports.
‘4 o See your camcorder instruction manual for connecting instructions.

Insert a memory card containing images into the camcorder.

Connect the power adapter to the camcorder.

mode to PLAY by sliding the POWER switch down.

1
2
3 Turn the POWER switch to ON and change the camcorder
4 Move the '® /|y switch to ).
Wait until the card access indicator stops flashing.
5 Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
* The first time you connect the camcorder to the computer:
- Windows 2000: Installation of the DV TWAIN Driver starts. If the “Digital
signature not found” message appears, click [Yes].
- If you are prompted to restart the computer, restart the computer.
» A window appears allowing you to select an application program to start.
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* For instructions on how to start ZoomBrowser EX and download images to the
computer, see Downloading Still Images (ZoomBrowser EX) ([1] 27).

USB Terminal USB Cable

on the Camcorder
\ mEiE=t s

H

~¢— Camcorder End Computer End —

USB Port on
the Computer

26 I Before Downloading Still Images



| Downloading Still Images (ZoomBrowser EX)

76‘ o Observe the following precautions when the camcorder’s access indicator is
¥ flashing. Failure to do so may cause memory card data to become
corrupted.
- Do not remove the memory card or detach the USB cable.
- Do not turn off the camcorder or the computer.
- Do not change the position of the POWER switch or the "™ /@ switch.

o Images recorded onto memory card or downloaded to the hard disk are
important original data files. Create a copy of the file first before working on it
on your computer.

o Do not rotate the image using programs other than ZoomBrowser EX. The
data for the original image will be changed and the image can no longer be
displayed in ZoomBrowser EX or on the camcorder.

o If the Server Busy window appears when you connect the camcorder to the
computer, click [Retry].

Server Busy

Thiz action cannot be completed becauze the other
' program iz busy. Choose "Switch To' to activate the
. busy program and correct the problem.

O You cannot connect the camcorder to a computer if the memory card
contains 1800 images or more. In this case, use a card reader/writer to
download images.

- For instructions on how to connect a card reader/writer, see Using a Card
Reader/Writer ([ 1] 36).
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Starting CameraWindow

1 Connect the camcorder to the computer ([1] 25).

2 Select [Canon CameraWindow] and click [OK].

« If a camcorder and card reader are connected at the same time, a dialog
appears allowing you to select the camcorder model. Confirm that [Canon
Camera] or your camcorder model name is displayed and click [OK].

Canon ¥ % F % %

Camera connected

Select the program to launch for this action;

o -
B i

S Canon EOS Utility

é;l" Downloads images from EOS camera

) Microsoft Scanner and Camera 'Wizard
Download pictures from a camera or scanner

[ dshwayz uze this program far this action

» The Camera Control window opens.

& CameraWindow, - Canon FH 34
Acquire Images ﬁﬂ Setto Camera | Remote shooting

Dowrloads using camera

[¥] Diisplays this screen when the camera iz connected

2% © If the camcorder is already connected to the computer, you can start the
& CameraWindow and display the Camera Control window by clicking [Acquire
& Camera Settings] followed by [Connect to Camera] in the ZoomBrowser
EX Main Window.
o The Remote shooting function is not supported by your camcorder.
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Using the Computer to Download Still Images
You can select a downloading method in the Camera Control window.

B Auto-Downloading

1 Click [Starts to download images] in the Camera Control
window.

* For instructions on how to set the Auto-download settings, see Auto-
Downloading Settings ([I] 30).

» Click [Finish] to close the Camera Control window after downloading images.

& CameraWindow - Canon k343 %

Acquire Images | Frint | Setto Camera | Remote shooting

Dowrloads using camera

WL ] \;’J&N Press the camera's button

8 |
l ey Lets you select and download images

Dizplayz thiz screen when the camera iz connected

Freferences...
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B Auto-Downloading Settings

Select the setting for downloading images by operating your computer. You can
change the image type and the destination folder.

1 In the Camera Control window, click the [Acquire Images]
tab and click [Preferences].

& CameraWindow - Canon

Acquire Images | |3rint | Setto Camera | Remate shooting

Dowrloads uzing camera

¥ QQN Press the camera's button

= -
jg—l Lets you select and download images

Displays thiz screen when the camera iz connected

2 Select [Change auto download settings] and click [Next].

CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

() Change direct transfer download destination folder

(@ Change auto download settings )

Cancel
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3 Select the image type to be downloaded and click [Next].

CameraWindow - Auto Download Settings(1]

Select the image type to be downloaded.

(%) New images

() All images

() Images whose print order settings were specified with the camera

() Images whase bransfer settings were specified with the camera

Download Options

= | Wwhen the download iz complete, the original image iz deleted fram the camera.

Place a check mark here ——
if you wish the original image
in the memory card to be

deleted after downloading. (oo et D[ oo

4 Specify the destination folder settings and click [Next].

CameraWindow - Auto Download Settings(2)

Specify the location at which to save the image.

Destination Folder

A new folder will be created for each of the images' shooting dates in the following folder,
and the images wil be zaved there.

Do 5 0 |
CI|Ck ’[hIS button Browsze...

to SpeCify the Create Subfalder

deStination fOIder. :Shooting ‘YeartonthD ate v|
E=ample:

Select to Specify pE— DSD;DCDL;mBS-;S:;d SettingshCanonthy Documentsihy Pictures

the name of the

subfolder.

< Back Cancel
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5 Specify a process to perform after the image is downloaded.

CameraWindow - Auto Download Settings{3)

Specify process to perform after image is downloaded.

(%) Display the folder at the save destination

() Perform zelected processes consecutively

< Back Cancel

The window below will be displayed when you select [Perform selected
processes consecutively] (you can redisplay the window by clicking [Select]).
Select a process to perform after the image is downloaded, and click [OK].

Select Process

Fleaze zelect a tagk to wn after pour images
have been downloaded:

%) Wiew as a Shide Show
(") One Photo per Page Print
(3 Index Prirt
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6 cClick [Finish].

CameraWindow - Auto Download Settings{4) |Z|

Enable or disable the image auto-download function.

Placing a Check mark " | Images are automaticaly dawnloaded to computer while camera iz connected
here makes images in

the camcorder to be
automatically downloaded
when the camcorder is
connected.

< Back Cancel

B Downloading the Selected Still Images from the CameraWindow
1 Click [Lets you select and download images] in the Camera

Control window.
The CameraWindow opens.

& CameraWindow - Canon + 4% %

Acquire Images | F'rinl_| Setto Camera | Remote shooting|

Downloads uzing camera

‘Wh \\yQN Press the camera's button

Downloads using computer

46
% Starts to download images

o) _
%Q—l Lets you select and download images

Diizplayz thiz screen when the camera is connected

Downloading Still Images (ZoomBrowser EX) I 33



In the CameraWindow, select the image you wish to
download and click [Image Download].

* Clicking on 2 images while holding down the [Shift] key selects also all images
between the 2 images.

» Clicking on different images while holding down the [Ctrl] key selects multiple
images.

& CameraWindow - Canon &% #4 &

File(F) Edit(E) Wiew(¥) Help(H)

=

= £ | File Informatiary
| g}- Image Download

5\5 Print ~ E@Etan ZoomBrowser EX e I e

P Modiied:  200%/01/1514:43:28
5 . = =@
2ot J FleSize:  B0KB

Image Size:  B40x480

_# | Histogram:

A blue frame
appears around
the selected image.

IMG_0102.JPG IMG_0103.JPG IMG_0104.JPG

_#| Detais:

Ttem Mame Vale A
File Hame IMG_010
Camera Model N...  Canon
Shodting DatefTi... 1/15(200
ShootingMode  Partrait
Photo EFfect Off

Tv (Shutter Speed) 140

Av (Aperture Yal... 2.0

[ ——

Light Metering Evaluatiy
Expasure Camp. .

130 Speed Auto

Lens 2.6-65.1
Focal Length 7.8 mm
Digital Zoom Mone
Image Size 640480
Image Quality Fine

< >
Selects image 1 of 4

Confirm the settings and click [Starts Download].

« ZoomBrowser EX starts, and the downloaded images appear in the Main
Window.

Cameraifindow: - Download Images

- N
_ Ve _\_' Download images according o the following settings.
"‘-..,.‘,:___

Settings for the folder and the
subfolder for downloaded images

Specify File Marme
Settings for the fiI.e prefix : Do rot modify
and the consecutive numbers

:( Starts Download )j [
S

Specify Folder
Save to [Folder Name)
C:ADocuments and Settingz'Canon'My Documents
Create Sub Folder
Shooting YeartonthDate
\
J
]

[ Change Settings...

Cancel ]

» To make changes, click [Change Settings].
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[Specify Folder] Tab

CameraWindow - Change Settings

SpeCIfy the Settings of Specify Folder | Specify Fils Name |
the folder and subfolder.

Save to [Folder Mame)

|E:\Documents and SettingshCanonsky Documents | [ Browse. |

A zubfolder into which the image will be zaved will automatically be created in thiz folder.

Create Subfolder
| Shooting YeartonthD ate w |

e :

Example;

G CADocuments and SettingshCanon'skdy Documents
] 200%_M_15

ag. ] ’ Cancel

[Specify File Name] Tab

CameralWindowr - Change Settings

Specify the file name with ——smmrramr Seecity File Name |
which to save the images.

Specity File Marme:

|
Azzigh Sequence o
Murnber of Digits |4 = ng
el 10 [T
Exarmiple
[Hr file'emtension il be the same as the ariginalfle name]

ak. ] [ Cancel
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B Using a Card Reader/Writer

The basic operations are the same as when you connect the camcorder to the
computer. Follow the procedure below to open the CameraWindow. For instructions
on how to connect the card reader/writer, refer to its manual.

o8 If your card reader/writer does not support miniSD cards, obtain an appropriate
- adapter for the card.

1 Insert a memory card containing images recorded with the
camcorder into the reader.

2 Windows Vista/Windows XP: When a window appears
allowing you to select an application program to start, select
[View/Download Images using Canon CameraWindow] and
click [OK].

Windows 2000: Click the Windows [Start] menu, and select
[Programs], [Canon Utilities], [CameraWindow],
[CameraWindowMC] and [CameraWindow].

2P Clicking [Acquire & Camera Settings] » [Acquire Images from Memory Card]
“Z in the Task Area of the Main Window of ZoomBrowser EX also opens the
Camera Control window.

3 Select a downloading method.

* [Starts to download images]: A progress bar will be displayed and images will
be downloaded to the computer, and ZoomBrowser EX starts. For instructions
on how to set the Auto-download settings, see Auto-Downloading Settings
([1130).

* [Lets you select and download images]: The CameraWindow opens,
displaying the camcorder images as thumbnails (small images).

& CameraWindow - G:\DCIM

Acquiie Images | Print |

Starts to download images

Lets you select and download images
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Using the Camcorder to Download Still Images (Direct
Transfer Function)

If your camcorder supports the Direct Transfer function, you can use the camcorder to
download images.

B Setting the Direct Transfer Download Destination Folder

1 In the Camera Control window, click the [Acquire Images]
tab and click [Preferences].

& CameraWindow - Canon 3433 %

Acquire Images | |3int | Setto Camera | Remote shooting

Downloads using camera

WL \-'-’JQ'N Press the camera's button

Diizplays this screen when the camera iz connected

| Preferences... |

2 Select [Change direct transfer download destination folder]
and click [Next].

CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

(@ Change direct transter download destination folder )

(") Change auto downlaad settings

Cancel
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3 Specify the destination folder settings and click [Finish].

CameraWindow - Auto Download Settings{?)

Specify the location at which to save the image.

Destination Folder
A new folder will be created for each of the images' shaating dates in the following folder,

and the images wil be zaved there.

CI|Ck th|S button Browsze...

to specify the Create Subfolder

destination folder. Shooting eardanthDate v
Example:

Select tO Specify c— B | SD;DCDL;m_?;;a;d SettingzhCanonsky Documentsiby Pictures

the name of the

subfolder.

< Back Cancel

B Direct Transfer

1 Select a transfer option on the camcorder screen and press
the D~~~ button.

» See your camcorder instruction manual for how to set and operate the
camcorder to transfer images.

« The ;a7 button cannot be used when it is not lighted.

* You can set the action that is carried out for direct transfer. Right-click the
[CameraWindow(Launcher)] icon on the taskbar and select an action from the
displayed menu.

- [Show image(s) in fullscreen e "
mode]: v Show imagels) in fullscreen mode
Displays downloaded images in |  Launch ZoomBrowser Ex
full screen mode. _ —

- [Launch ZoomBrowser EX]: v Shiow WWindow

Starts ZoomBrowser EX after —_

downloading the images. | About CameraWindow(Launcher), ..
- [Show Window]:

The Camera Control window Exit

appears when you connect the
camcorder to the computer.

2 Press the [0y~~ button on the camcorder.
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| Printing Still Images

Printing Still Iméages Recorded on the Memory Card

You can select one of the following 4 methods to print still images in the card without
downloading images to the computer.
* [Print All Photos]

- Prints all still images recorded on a memory card in the connected camcorder or in

a card reader/writer one image per page.
* [Print Contact Sheet with All Photos]

- Prints all still images recorded on a memory card in the connected camcorder or in
a card reader/writer in an index (rows of images with file names and image
information).

* [Print according to DPOF settings]
- Prints according to the DPOF print settings set by the camcorder.
* [Select an image and print]

- A list of the still images recorded on a memory card in the connected camcorder or
in a card reader/writer will be displayed, and you can select images you wish to
print.

1 Connect the camcorder to the computer. ([1]25)

2 Click the [Print] tab in the Camera Control window.

& CameraWindow - Canon 33k E]|E|

— - —_— . W
Acquire Image et to Camera | Remote shooting

Dowrloads uzing camera

= i
jg—l Lets you select and download images

Diizplayz thiz screen when the camera iz connected
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3 Click one of the 4 printing methods.

— N |

i) | PrintAll Photos

25/ | Print Contact Sheet with All Photos
— ; : :
hg Print according to DPOF settings

Select an image and print

\ J

Diizplayz thiz screen when the camera iz connected

4 Specify the print settings and click [Print].

The window varies depending on the selected printing method in step 3.
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When you have selected [Print All Photos]:

Sets the paper size Rotates still images.
and orientation.
Click this to use the trimming function
Selects the printer. (crops a portion of the still image).

Frinter Frewview

Marne: i) [

|Canon ) "| lﬁil nglj u
i Fiotate Left  Fotate Right Trim Image

[ Propeties. |

(MediaType:

|Plain Faper v|

Faper Size: -

| Letter hd |

Orientation:

\‘@ Porrait O Landscape

Tatal: 4 pages
Fage Layout Settings

Auto Trim

[ Bordetless

Select additional information
to printwith your images:

[[] Shoating Date
[[] Shoating Time

Text Color: (|

opies: |1 '?
{ 4__' Image: 1/ 4 E
il

]
Cancel

Click this button to switch between still images

Sets the auto trim if multiple images are selected.

(crops image edges

according to the page — Sets the number of print copies of the displayed image.
proportions) or

borderless print settings. ~—=Sets the shooting date/time imprint and color settings.
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When you have selected [Print Contact Sheet with All Photos]:

Sets the paper size Rotates still images.

and orientation.
Click this to use the trimming function

Selects the printer. (crops a portion of the still image).

indexcprintSottings I S I Y -

Frinter Sreniew

Marne: 5
Canan i
! EERXL i | Fiotate Left  Fotate Right Trim Image

Properties...

Media Type:

| Plain Paper v
Faper Size:

| Letter |

Orientation:
O Forrait O Landscape

-~

Copies: j1 2

Tatal: 1 pages

Fage Layout Settings

Colurnns: 3

Fiowes: 3

43 (43

.

f
[¥] Shooting Infarmation

[IHeadet/Footer
. —= — X
4 Page: 1/1 »
| ]
Sets the print settings Click these buttons to switch between pages.

for shooting information,
comments, headers,
footers and page
numbers.

—— Sets the number of print copies of the contact sheets.

Sets the number of rows and columns.

When you have selected [Print according to DPOF settings]:

* The selected still images will be printed according to the number of copies set with
the camcorder. The same window described in the previous section When you have
selected [Print All Photos]: ([T]41) will be displayed.
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When you have selected [Select an image and print]:

* If you selected [Select an image and print], the following window will be displayed.
Select still images you wish to print, and click [Print]. If you selected [Contact Sheet
Print], the same window described in the previous section When you have selected
[Print Contact Sheet with All Photos]: ([ ] 42) will be displayed. If you selected [One
Photo Per Page Print], the same window described in the previous section When you
have selected [Print All Photos]: ([1]41) will be displayed instead. Set the print
settings and print the still images.

& CameraWindow - Canon o 4k
File{F) Edt{E) Wiewy) HelpiH)

= - S _# | File Information:
;;_‘,i‘l Image Dowrl(d ['-i&\ Print = ﬁstart ZoamBrowser EX File Mame:  IMG_0101JPG
“ Modified: 20001415 14:49:28
Select - = J =@

File Size: 80 KB
Image Size:  GA0«480

ﬂ Hiztagram;

IMG_0101JPG IMG_0102.JFPG IMG_0103.PG IMG_0104.JFG

3| &1 Details:
Them Hame Walue A
File Mame IMG_010

Camera Madel M., Canon s
Shoating Date/Ti... 1f15f200
Shoating Mode Portrait
Phioto Effect Off

|| Tv (Shutter Speed) 140

Ay (Aperture Yal,,, Z.0

Light Metering Evaluativ
Exposure Comp... 0

IS0 Speed Auto

Lens 2.6-65.
Focal Length 7.2 mm
Digital Zoom MNone
Image Size 40430
Image Cuality Fine e
4 i >

Selects image 1 of 4

Printing Still Images I 43



Printing Still Images Downloaded to the Computer

You can select one of the following 2 methods to print still images downloaded to the
computer.
* [One Photo per Page Print]
- Prints one still image per page.
* [Index Print]
- Prints selected images in rows with file names and image information.

You can select the program to use for printing by clicking [Print] in the Main
Window and selecting [Print Using Other Software].

B [One Photo per Page Print]

1 Click [Print] in the Main Window and click [One Photo per
Page Print].

7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy DocumentsiMy Pictures
File Edit Yiew Tools Internet Help

[Tasks 6]‘ Wiew Iiag Propettie @Shdeﬁhnw @Search Delete Rotate ‘

= — ——~ - S —— "
Acquire & Camera Seltings l Zoom Mode ‘SCIU"MUdE_ Preview Mode | _
My Fictures € > 4 E-0- [k [EN [ T File Tod
Fr- 7 Wiew & Clagsify l
3] 200¢_01_15
Edit
l@ Export l
)
1

MB ?6

H ‘MG 0104, Jh

2 Select still images you wish to print and click [Printer and
Layout Settings].

| One Phato per Page Frint

7\
7
=i

- |

Index Print

e ]

Print Using Other Software

| [ Intermet

#7 ZoomBrowser EX - C:\Documents and Settings\Canonidy Documents\Wy Pictures

Fil= Edit Yiew Tools Intermet  Help

Help

ZoomMade | Scroll Mode !’ﬁaviemﬁd@l
My Pictures € > 4 |[H-0- |1 & e [ T Filer Tod

3 Retum ta bain Menu
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3 Specify the print settings and click [Print].

Sets the paper size and orientation. Rotates still images.

Click this to use the trimming function

Selects the printer.
(crops a portion of the still image).

7 ZoomBrowser, EX - C:\Documents and SettingsiCan| hi\My Documents BIEHZ‘

File Edit WView Tools Internet Help
Help

One Photo per Page Print STEP 2: Sp| [eify Printer and Layout Setting

‘ 1. SelectImages ‘ Frinter

MName

[ Printer and Lavout Settings ‘ [Camonwsce 9]
‘ 3. Print | > W]
:—: Media Type

Flain Paper W

Paper Size:

Fuotate Left  Rotate Right

Letter b
3 Retun to Main Menu
Orientation

@Faortrait O Landscape

Taotal: 4 pages

FPage Layout Setiings

Auto Trim
[ Barderless

Select additional information
to print with your images:

[] Shooting Date
[ Shooting Time

Text Color: [

Copies: |1 &

| Image: 1/ 4

Click this button to switch between still
images if multiple images are selected.

Sets the number of print copies of the displayed image.

Sets the shooting date/time imprint and color settings.

Sets the auto trim (crops image edges according to the page proportions) or borderless
print settings.
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B [Index Print]

1 Click [Print] in the Main Window and click [Index Print].

£ ZoomBrowser, EX - C:\Documents and SettingsiCanoniby Documentsiy Pictures

File Edit View Took Internet Help

[ — e] | view Tmage = Properties @Shde Show @ Search ’ Delete [0 Rotate
@ Acquire & Camera Settings
[f_/ “iew & Classify

[@ Edit

[@ Export

[@ Frint l :
Lme e J IMG_0101L.0PG  IMG_0102.FG
~ 3
7

ZoomMode | Serll Mode | Preview Mode |

Iy Fictures L + @ -0 - |E|Q 4 J—‘ ,l,? Filter Tool

@ 200%_01_15

{  Index Print

r||w

rpllnt Using Other Software

< IMG_0103.0PG  IMG_D104, PG
\@ Internet

2 Select the still images you wish to print and click [Printer
and Layout Settings].

£ ZoomBrowser, EX - C:\Documents and SettingsiCanoniby DocumentsiMy Pictures
File Edit ‘iew Tools Internet Help

Index Print 8 Help -n
Zoom Mode | Scrall Mode | Preview Made |

= My Pictures € + | -9 - [EQ L _]-‘ L Filter Tool

2. Printer and Layout Settings
= =
. : =
=8 Print -
[ 3 Retum to Main Menu ! - :

.r_‘ .
_J.

Select Images

_Jl |
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3 Specify the print settings and click [Print].

Sets the paper size and orientation. — Rotates still images.

Selects the printer. Click this to use the trimming function

(crops a portion of the still image).

& ZoomBrowser EX - C:\Documents and SettingsiCan| iy Documents ‘LHEHE\
Fle Edit Wiew Tools Internet Help
Help

-
Sl InddescPrint

Printar

1. SelectImages

MName

Printer and Layout 5 ettings Canon mos 9

Media Type

Flain Paper v

Faper Size

Orientation
@ Partrait O Landscape

Copies: |1 3

Total: 1 pages

T

Pace LavnutSem_nus
Columns:

Rows:

Shooting Infarmation

[ HeaderFooter

Setings

L <| Page. 1/1

Click these buttons to switch between pages.

Sets the print settings for shooting information, comments, headers, footers and
page numbers.

Sets the number of rows and columns.

Sets the number of print copies of the contact sheets.
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| Organizing Images

Applying Star Ratings and Keywords

This task allows you to apply ratings to your images from one star to three stars. The
star rating can be used as one of the search conditions, or for the selection of images
to be displayed in the Browser Window. The keyword can be used as one of the
search conditions.

1 Select the image to which you wish to apply the star rating
or keyword, and select [View/Modify Keywords] from the
[Tools] menu.

Manaje Fevmoras. ..

I FIOCE

_ustomize. ..
Preferences. ..

[

2 Place a check mark next tor the keywbrd you wish to apply,
or click on the stars for rating.

1" View/Modify Keywords

Check or uncheck the bores to change the way Kewwords are applied to the selected files. To add a new Kewword. type the name in the
text field below the desired categary, and press the + button,

People: Places: Ewents: Others: )
[ Children 1 Beach [ Birthclay
] Family | [ Citw | [ Haliday
1 Friends ‘ [ Home | [ Party
p—— -
e )

Select the star rating to assign ta the selected files
e

Cancel

2Py © The default setting of the star rating is two stars.
# © You can add and delete keywords, or change the keyword list in the [Manage
Keywords] window by selecting [Manage Keywords] from the [Tools] menu.
o Windows Vista: The star rating set using ZoomBrowser EX is not related to
the “Rating” setting in Windows Photo Gallery and Windows Explorer.
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Classifying the Images

This task allows you to classify selected images according to the shooting date.

1 Click [View & Classify] in the Main Window.

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniby DocumentsiMy Pictures

File Edit Yiew Tools Intermet Help

[ T 6] @Shdg Shaw @ Search

@ Acquire & Camera Seltings J Zoom Made | Serol Mude | Preview Mode | .
My Pictures € 4+ H-0-|k|& e [ F Fiter Tonl
Ir:j iew & Clagsify

| |
|

.

l@ Export
l% Frint
l Internet

2 Click [Classify into Folder].

IME_0101IPG  IMG_0102.1PG

o7 ZoomBrowser EX. - C:\Documents and SettingsiCanonihy DocumentsiMy Pictures

File Edit Yiew Tools Intermet Help

[ T 6 ] Yiew Trnage E e @ B S @ ey = Rotate

Zoom Made | Seroll Mode | Freview Mode |

My Pictures € 4+ B0 e E e | 5T Filer Tod

3] 20m<_m_15

View az a Slide Show

LF!Ename tultiple Files J
—
)

= —

| Classify inta Folder
N
rS eaich 1

3 Select the images you wish to classify and click [Specify
Classification Settings].

Zoom Mode | Seroll Mode | Preview Mnde‘i

My Pictures € allm-0-(h®R e [ F Fiter Tool

(8 IMG_0102.JPG
3 Retum ta b ain Menu =
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4 Specify the folder structure and the saving folder and click
[Finish].

The selected images are classified into the specified folder.

&1 ZoomBrowser BX - C:\Documents and Settings\Canonisy Documents
File Edit Wiew Tools Internst Help

1. Selectimages (f fecity Folder Structure When classifying by shooting \
date. ZoomBrowser EXwill only

classify photos with shooting

Specify Classification Settings

{ u:"‘ Specify folder structure:

—l A iYearMnnthDale V‘ date information and skip owver
e
-> '3/ photos without shooting date
Finish Ei . = Example Folder Structure infarmation
‘T‘ = ChDocuments and SettingsiCanoniby Documents
200%_00_15 By default. ZoomBrowser EX
- copies the onginal photos to the
new folders. To save space on
wour computer, choose fo move
the photos instead
I Return to Main Menu
Sawve to Folder
J Where would you like these folders to be created?
E‘ @ Current Folder
E:'l O My Pictures

O Specity Folder

‘C.\Ducumenta and SettingsiCanoniiy Documents

Copy or Mowe Images

@ Copy
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Renaming Multiple Files

This task allows you to rename multiple files at the same time, or to rename and copy
multiple files.

1 Click [View & Classify] in the Main Window.

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniby DocumentsiMy Pictures

File Edit Yiew Tools Intermet Help

[ Tasks 6] View Tmage Properties @ Slidz Shiow @ Search

o J Zoom Mode | Seroll Mods | Preview Mode |

My Fictures €2 ¢ |H-0-(r& =t ([ F FterTonl |
F = Viw Clssiy p ‘
r@ " “ 3} 200%_01_15 —
[ oo | .. -
l% Print l ‘ .
= |
2 Click [Rename Multiple Files].

.[—#

IME_0101IPG  IMG_0102.1PG

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures |;”E|E‘

@ Slide Shaw @ Search Delete EA Ratate

Zoom Made | Seroll Mode | Freview Mode |

File Edit Yiew Tools Intermet Help

[ Tasks

@ Acquire & Camera Settings
F}’ “iew & Clazsify

Wiewn &z & Slide Show

My Pictures € 4 |E-0-[h]& e [ F Fiter Tool

%) 200%_01_15

—

_.l_ @]

'
| Rename Multiple Files
D

Claszsity inta Falder

Search

3 Select the images you wish to rename and click [Specify
Rename Settings].

w1 ZoomBrowser EX - C:\Dacuments and SettingsiCanonby Documentsidy Pictures

File Edit Yiew Toolk Internet Help

Zoom Mode 1 . -
My Pictures €7 4 | H-0- |l|@l _].m L7 Filter Tool

%) 200%_01_15

I Retum to Main Menu
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4 Specify the settings and click [Finish].

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents |Z”E”z‘

Help

File Edit View Tools Internst Help

@ Rename Multiple Files STEP 2 Specify Rename Seftings

Rename Seftings Renaming your photos can
make searching for them much
easier

1. Select Images

Select how files should he renamed:

[~ ]
-

FiW
A/

Specify Rename Settings
@ New Name + Number

) Shooting Date + Number @ ‘@

123.0PG 456.JPG

O New MName + Shooting Date + Mumber
© Shooting Date + New Name + Number

] Make copies of files |@ ‘gl

AN JPG A D02 JPG

Specify name [ NEWNAME
—— By default ZoamBrowser Ex
Mumber of digits 3 | creates and renames copies af
3 Aetum to Main Mefu —_— the ariginal photos. To save
Start number. 1 | SpaCe on your computer,

choose to rename the original

Example of new file name: photos instead

NEWNAME_001 00
\ MNOTE: The original data type (00 will be retained. /

Placing a check mark here makes copies of images with new names.
The name of the original images will not be changed.

2P Torename a folder, select a folder, and open the [Rename Folder] window by
& selecting [Rename] from the [File] menu. Input the new name, and click [OK].
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Searching for Images

This task allows you to search for images by star rating, modification date, shooting
date, comment or keywords.

1 Click [View & Classify] in the Main Window.

You can also search for images by clicking [Search] on the Application Tool Bar.
Skip to step 3.

7 ZoomBrowsen EX - C:\Documents and SettingsiCanoniy Documentsity Pictures

File Edit VEWTI Inter tHIp

[ Tazks 6 ] ‘

@ Slide Show [@ Search]

L Acquire & Camera Settings J
= = <

Zoom Mode | Serall Mode | Preview I_'dode

My Pictures

&

Jr—r-_r‘ﬁ.‘ ,;? Filter Taal

w ,_/‘ Wiew & Clazsify

[@ Edit
=

E 200 _01_15

-
|
|
|

IMG_D101.0PG  IMG_D102.0PG

2 Select folders and images from which you wish to search

and click [Search].

#7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniiy Doc umentsity Pictures

File Edit View Tools Internet Help

View az a Slide Show

Rename Multiple Files

Clazsify inta Falder

7\
N/ " .

Edit

]

[ Tasks 6 ]‘ . Propetties Shda Shaw @ Search ﬁ Delete |al

@ Acquire & Camera Selings Z oom M d \ SCIOH Mode | F'rewew Mode,

= Iy Pictures € 4 m -0 - ‘@l - : D—m"% ,l,? Filter Tool
E—ﬁi‘/ Wiew & Classify
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3 Specify the search conditions and click [Start Search].

* The search results are displayed as thumbnails.
* Select at least one search condition.

o' ZoomBrowser EX - C:\Documents and Settings\CanoniMy Documents

File Edit Yiew Toals Internet Help

i@ Search STEP A lil
1. Select Search Region O il et © Match any conditian

Star Rating

Specify Search Conditions

Find images with the selected star rating

[ Modification Date

Findirmages based on the date they were last modified

Start Date: 972342005
Enel Date: 972342005

] Shooting Date

! 2 StatSearch

Finish

(5 ounoroniens |

Find images based on the date they were shot

Start Date: 92372005
End Date 972372005

Searching onthe shooting date may take a few moments for large numbers ofimages

[ Comment

Find images that hawve comments containing the following words.

[ keywords
\ Find images you have tagged with keywords J

4 cCiick [Finish].
 To change the search parameters and perform another search, click [Specify
Search Conditions] and repeat steps 3-4.

=7 ZoomBrowser EX. - C:\Documents.and Setti nontiy Documents

File Edit View Tools Intermet Help

0103, PG IM
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» The images of the search result are displayed in the [Search Results] folder.
You can print or copy these images to another folder.

Favorite Folders
=% My Pictures
%) 200%_01_15

e Tu (n P L =1

—r Ce— =

Folders Area

I 1

oy The searched images will remain in this folder until ZoomBrowser EX is closed
< or another search is performed, but if you delete an image in this folder, the
corresponding original image will be deleted as well.
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| Creating a Movie from the Still Images

Editing Movies

You can link still images, insert text and background music, and add effects. You can
also change the size of selected movies and save them as new files.

@ o If you are using Windows 2000, QuickTime is required to edit movies. If it is
\ o/ not already installed on your computer, install it from the DIGITAL VIDEO
Solution Disk. Place the disk in the CD-ROM drive and click [Install] under
QuickTime in the installer panel.
o If you have an AVI file in your computer, you can use this function to edit the
file.

1 Click [Edit] in the Main Window.

7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures
File Edit ‘iew Tools Intermet Help

="

',;F' Wiew & Classify
= S —
I —
F@ Export
l% Frint
l Internet

2 Click [Edit Movie].

200b+_01_20

[ Tasks [2) C}QDP Slidz Show ‘Q Search
@ Acquire & Camera Settings Zoom Mods | Scrol Mode | Freview Mode_ -
— Iy Pictures “L_._-—’- 4,? Filter Tool |
D

|
4
7
%

MG_0107.0PG  IMG_D108, PG
—

-

File Edit View Tools Internet Help

[ Tasks @] |__r"»=‘_—’-| & Prope; -7 Slide Shaw [Q Search
@ heoyiie® Camera Selings ] Zoom Mode | Serall Made | Preview Mode | _ B =
= Iy Pictures € 5 A EH-0- IL|@I a Jrr—""" ,l,? Filter Taol ||
\@ Vi & Classify ] 1
’ ] 200_01_20 ‘-
Edit
LEdilImage J
——————_
i )
_EEE—— T

| -
| IMG_0107.0PG  IMG_0108.FG
| —l— ) —
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Select images and click [Arrange].
You can select multiple images or a folder to include all images in that folder.

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniby DocumentsiMy Pictures

File Edit Yiew Tools Internet Help

ﬁ’ Edit bMovie STEP 1. Add images

i Add]Imhges ~8 Zoom Mode ‘ Seol Mode | Preview Mode |
A Iy Fichures _L‘ ::'., Filter Taol
< 2. Amange >
EE————— 200%_071_20

3. Apply Effect r

4. SetAudio

5. Save |

bl

Arrange images and click [Apply Effect].

To change the order of images, select an image in the Storyboard Area and click
[Move Left] or [Move Right].

&7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniky Documents
File Edit ‘iew Tools Internet Help

Edit Mowie STEPR 2: Arrange images.

i Alrange
1. AddImages . . )
Ta arange images, select the image and click on the [Move Left] or [Move Right]
buttars

Amange

(@

|

\& A

I; : .| e
@E@ [ Moveleft | [ Move Riaht |

)

To get the play time or rotation. select the image and click the button,
4. Setdudio

5. Save | I Play Time L Ratate ]

6. Ext

3 Retum to Main Menu

Total Time: 00:10

Selected Thems: 2

Plays back the movies Storyboard Area

being edited. Displays thumbnails of the
selected images. The images will
be linked from left to right.

Transition Box
Displays the symbol of the transition
effect between linked images.
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5 Apply effects to the images and click [Set Audio].
When you select [Apply effects to image.], you can use the following functions.

- [Text Effect]: Opens the [Text Effect Settings] window. You can enter text,
change the font and preview the effect.

- [Filter Effect]: Opens the [Filter Effect Settings] window. You can set the filter
effect type, the start and end point, and preview the effect.

- [Magnify Section]: Allows you to view a part of the image in enlarged size.

- [Transition Effect]: Opens the [Transition Effect Settings] window. You can
set the transition effect type and display time, and preview the effect. To set
a transition effect, you need to select a transition box in the Storyboard Area.

7" ZoomBrowser EX - C:\Documents and SettingsiCanoniy Doc uments

Tools  Inkernet  Help

Image Effects

1. AddImages (O lse imane a3 is

® Apnl}l effects to image.

2. Arange l @EG To et the Text effect, Filter effect, or to maanify a section, select the image and click the
appropriate button
Apply Effect J ] [ ] [ ]
=
)
;‘J

[ =

r|| \|

Text Effect Filter E ffec! i agnify Sectio

“when yau want to set the image's Transition effect, select the [Transiion Effect] bax

4. SetAudio click. the [Transwtlon Effect] buttan.

8 Save Transition Effect

6. Exit l

6 Set the audio and click [Save].
When you select [Set audio.], you can use the following functions.

- [Add Audio]: Opens the [Add Audio] window. You can add an MP3 or a WAV
file as background music.

- [Advanced Settings]: Opens the [Advanced Audio Settings] window. You can
adjust the audio level of a movie or an audio file and apply audio faders. To
set the advanced audio settings, you need to select a movie or an audio file
which you added.

&7 ZoomBrowser EX - G:\Documents and Settings\Canoniy Documents

Fil= Edit VYiew Tools Internet  Help

o ‘ Edlit Mowvie ‘ STEF 4: Set audio.
Audio
1. Add Images [ TP
1 - ) Set audio.
2 Amange . T add audia, click the [Add Audio] buttan
N 3. Apply Effect Add Audio

Set Audio To get advanced audio setings. select [Audio] and click the [Advanced Settings] button.

Advanced Settings
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1 Click [Save].

Movies are saved in DCF type files with Motion JPEG/AVI compression.

7 ZoomBrowsen EX - C:\Documents and SettingsiCanoniMy Documents

File Edit View Tools Internet Help

1. AddImages

2. Anange

3. Apply Effect

4. Setfudio
Save
B Exit

I 3 Retumn ta Main Menu

l

Save file

File narme:

E‘ Mowe
L‘/l Save to folder

|C WDocuments and SettingstCanonitdy Documerits ‘ [ Browse

Save image type
%) Auto-select
() Specify a save image ype

e ——

Save image type: Moo G [&Y])
Image Size:320 & 240 [Standard)
Frame Rate:15 Frames/secand
Audio 16 bit, 22.050 kHz, Monaural
(Total Time: 0010

Click [Save] button to save the edit results,

Select this to save as Motion JPEG compressed AVI.

Selecting [Specify a save image type] and clicking [Advanced Settings] allows
you to set [Image Size], [Frame Rate] or [Audio] settings of the movie.

8 click [Exit].

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents

File Edit VWiew Tools Intermet Help

Save filz
1. AddImages File: narme:
2. Anange
|’J Save o folder:
‘E “Documents and Settings\Canoni\ty Documents | Browse
3. Apply Effect
. - Save imane typ -
4. Sethudio (&) Auto-select
() Specify a save image type ‘
Save. MatianF Advanced Settings |
ié'a-vé'\-lﬂage type:tation] PEG [Al] -

!\mage Size: 320 # 240 [Standard)
[Frame R ate:15 Framss/second
Audic:1 6 bit, 22.080 kHz, Monaural
Tatal Time: 00:10

Click [Save] button ta save the edit results.

Save
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Playing Back Movies

In the CameraWindow and Main Window, movies are displayed with the first scene as
a still image with a (movie) icon.

o If you are using Windows 2000, QuickTime is required to play movies. If it is

& not already installed on your computer, install it from the DIGITAL VIDEO
Solution Disk. Place the disk in the CD-ROM drive and click [Install] under
QuickTime in the installer panel.

o Do not double-click a movie file (.AVI extension) in Windows Explorer. That
will start Windows Media Player, which may not support this file type. To play
back movies, double-click the thumbnail with a movie icon in the Main
Window’s Browser Area.

1 In the Main Window, double-click a thumbnail with a
(movie) icon.
[Image Viewer] window appears.

#7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniiy Doc umentsity Pictures

=
DF Slide show ‘a Search ¥

Zoom Mode | Serall Mads | Preview Mode|
by Fictures € 4 R~

File Edit View Tools Internet Help

[ Tasks @
E_@ Acquire & Camera Settings

]

|

[[.Tﬂg-; “iew & Classify l
@ Edit
| i =

l

Favorite Folders | 4| Faldzrs

Last dcquired Images ‘ ‘

=] All Images ‘ | —

(= 24 shooting Date < ‘ ‘ MYI_01086, AY]
8 oo nt | |
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» The [Image Viewer] window is displayed, and the movie will be played back.
You can control (play back/stop/fast forward/rewind) the movie being played
back with the buttons shown at the bottom left of the window.

» Windows Vista/Windows XP: You can extract still images from movies and
save them as image files. For details, refer to Extracting Still Images from
Movies (Windows Vista/Windows XP) ([ 1] 69).

You can save the displayed scene as a still image.

[=] ZoomBrowsern EX - C:¥Documents and SettingsiCanoniMy Documentsity Picturesi200X_01_20iMY1 0106.... @gj
File Edit Wiew Help

You can play movies and control the sound volume.
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| Exporting Images

You can change the data type for selected still images and movies and save them as
new files. You can also export selected movies and still image properties to a text file
or copy and rename movies and still images. Furthermore, you can export still images
for use as a screen saver or a wallpaper.

Changing the File Type and Saving

1 Click [Export] in the Main Window.

£ ZoomBrowser, BX - C:\Documents and SettingsiCanoniiy Doc umentsity Pictures

Fil= Edit View Tools Internet Help

= =N
[Tasks 3l Slids Show Q Search

) Acquire & Camera Settings

Zoom Mode | Serall Mads | Preview Mode|

= by Fictures 45 [} -0 - k "i".% _I,-——*‘_'_ ::Yﬂ Filter Tanl
F-E-_ Wiew & Classify
3] 200%_01_15

’i@ Edit

)
|
|

J

-

Q #por ;
= e —————— .
@‘ Frint ‘
l . l MG _0101L.0PG MG 0102, PG
= —— il

2 Select the export type.
If you selected [Export Movies], [Extract frames from a movie] or [Backup to
CD], refer to the pages listed below.
[Export Movies]: Exporting Movies ([ 1] 66)
[Extract frames from a movie]: Extracting Still Images from Movies (Windows
Vista/Windows XP) ([ 1] 69)
[Backup to CD]: Saving on CD-R/RW Disks (Windows Vista/Windows XP)

(72)

£ ZoomBrowser B - C:ADocuments and SettingsiCanoniy Doc ume nts Wy Pictures

“FHiES @ Slide Shaw @ search Delete

Zoom Mode | Serall Made | Preview Mode |

c % m-0- (v —

File Edit VYiew Tools Internet Help

“ Tasks [z}
l'@ Ed
@ -

@

Export Still Images

Extract frames from a movie

Export as a Screen Saver

Export az a\wallpaper

(
L
l
=
|

Backup to CD

\

& |
B L

3 3 I
IMG_0103.0FG  IMG_D104,JFG
200_01_20
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3 Select images and click [Specify Export Settings].

&7 ZoomBrowser E% - C:ADocuments and SettingsiCanoniby DocumentsiMy Pictures

File Edit View Tools Internet Help

Zoom Mode | Seroll Mode | Preview Mode

Select Images
(

XJac o es
= —— = Iy Pictures € 4 m -0 - |l|§& W ::Yﬂ Filter Taal
| 2. Specity Export Settings )
F— 8 200%_01_15

3. Finigh

[ 3 Retum to Main Menu ]

4 Specify the export settings and click [Finish].

The window varies depending on the selected export type in step 2.

When you have selected [Export Still Images]:

You can convert still images to another file type, resize and save them as new files.
You can select the file type from BMP, JPEG and TIFF. You can also specify a prefix to
be added to the exported still images.

#7 ZoomBrowser BX - C:\Documents and Settingsi\Canon\My Documents |:|E|rg‘
File Edit Wiew Tools Internet Help

‘::-‘E Export Still Images STEP 2 Specify the export setiings
‘ 1. Select Images ‘ Image Setings You can reduce the amount of
[[] Resize images during export memory your files use: by
Specify Export Settings resizing the images to a smaller

Long sielés size.

>~ ~
e

s ~ l IEI EII a0n pixels

le—al

Short side

I

6

EI I:l pixels
e

[ Change image type When expoting images as
(o 5 i JPEGs. you can also reduce file
iMta,| —
|ELP_ L/ -, B sizes by using & lower Quality
setting which compresses the
Original File Size 828 KB image more. The images won't

Madific i kA look as shamp butthe file sizes

will be smaller.

3 Returm to Main Meru

- File Mame Settings

abc [ Add a prefix IMC

Save o Folder

© Current Folder
B O iy Pictures

O Specity Folder

Q‘\Dncumems and Settings\CanoniMy Documents J
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64

When you have selected [Export Shooting Properties]:
You can select the information you wish to export and save as a text file.

=1 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy Documents

File Edit View Tools Internet Help

Expon Settings

L Specify Export Settings J

>~ ~

. —
|

I 9 Retum to Main Menu | |

Select shooting properies to export

Active AF Points
[v] AF Mode
AF Fange Mode

utoexposure Bracketing

Digital Exposure Compensation
[ Dinital Zanm

|

€

l

SelectAl | [ Clearanl |

Save to File

Specify file narme and falder

=

‘C.\Ducumenls and SettingsiCan. AZBShootingProperties.hd

NOTE: Properties will he saved as * bt

Files without shooting properties will not be exported.

Shooting properies are stored
inimages as EXIF information

EXIF stands for Exchangeahle
Image File Format and is used
by most camera manufacturers.

When you have selected [Export as a Screen Saver]:
You can export and save the image as a screen saver.

¥ ZoomBrowser EX - C:A\Documents and Settings\Canoniy Documentsiiy Pictures

Fil= Edit View Tools Internet Help

3 Return to Main Menu

Exporting Images

Screen saver size

SgEs! i

1024708

OKE

[ Presdiew Screen Saver, ]

- Save to File

/f

Specify file name and falder

f Screen Sawver Settings \

[ Include images in the screen saver (larger file size)

Calculate

Save as..

ChDocuments and SettingsiCanoniky Documents\Canan
Llilities\ZB S creenSavenZES creenSawver.scr

Setas default screen saver

wTE Screen savers will be saved as Windows screen sever [*scr) files /

The order inwhich vou select
photos determines their
sequence in the screen sawver.

lf you selected to include
images in the screen saver, you
can reduce their size to fita
different screen resolution.

lf you choose not to include
images in the screen saver, and
wou then mowe ar rename these
images. they will not display
when the screen saver plays.

MNOTE:

lf wou cannot find your screen
sawer file on the Windows
Screen Savertah, youneed to
install it.

Erowse to the folder that
contains the screen sawver file,
right-click on the file, and then




When you have selected [Export as a Wallpaper]:
You can export and save the image as Windows wallpaper. This task cannot be
performed if you have selected multiple images.

o7 ZoomBrowser EX - C:\ocuments and Seitings\Canoniy Documents

File Edit View Tools Internst Help

Select Imagss

=

D

[ 3 Retum to Main Menu

~

=

> n

Saveto File

Li

{5 4 ify ) seftings
f Installation Settings Stretching small photos can \
pixelate and distort the photo
L Specify Export Settings J

@ Install centered
© Install stretched
O Install tiled

© Donotinstall

The wallpaper will be saved as:

& "ZBWallpaperbmp" in the default directony forwallpapers

O Specify file name and folder Save as

\NOTE' Wallpapers are saved as bitmap images (“bmp)

Try choosing Install centered ar
Installed tiled

Tiling replicates the phota, in its
original size, tao fitthe desktop
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Exporting Movies
You can change the size or file type for selected movies and save them as new files.

@ If you are using Windows 2000, QuickTime is required to export movies. If it is

\X¥J not already installed on your computer, install it from the DIGITAL VIDEO
Solution Disk. Place the disk in the CD-ROM drive and click [Install] under
QuickTime in the installer panel.

1 Click [Export] in the Main Window.

7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

File Edit ‘iew Tools Intermet Help

[ Tasks 6 ] WView Tmage Propettie @ Slidz Shiow @ Search
@ Acquire & Camera Seltings l Zoom Mode ‘ Scioll Mode | Preview Mode | .
= Wiy Pictures € 42 |H-0- (k& e [ F Fiter Tool
E/ “Wiew & Classify l

200_01_20
L@ Edit J
= ———
D

IMG_0107.0PG  IMG_D108, PG

et e 7 = -
2 Click [Export Movies].

File Edit ‘iew Tools Internet Help

[ Tasks Q] ol () @shdasmw @Saarth ﬁ Gl |@R e
l@ Edit
l@ Export

LEprrl Still Images

Export Movies

7 ZoomBrowser EX - C:ADocuments and Settings\Canoniy DocumentsiMy Pictures |Z|[E”z‘

L] Zoom Mode ‘ Seroll Made: ” Preview Mo&gl

My Pictures € 5 4 B-0-|[h]& ¢ = [ F FiteiTad

i/ —\|

Extract frames from a movie

L N

UL

Export Shooting Properties

Export as a Screen Saver

Export as a '/ allpaper

e RN

-

IMG__' IMYI_0106, AV

-

Backup to CD
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Select a movie and click [Select the save image type].
You can select multiple images or a folder to include all images in that folder.
Still images cannot be selected. For instructions on how to export still images,
see Exporting Images ([ 1] 62).

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniby DocumentsiMy Pictures
File Edit View Tools Internet Help

;::3 Export Movies 5 Help

Zoom Made | Scrall Mode | Preview Made |

Select Movies

/l

by Pictures € | m 0- | k |:l 4 J-‘ ::'ﬂ Filter Tool

[ 1 200_01_20
3. Setthe save image twpe

4. Specity name of file to be saved ‘ M 2
8. Start export k i

| IMG_0107.0PG  IMG_0108.JPG
[ 3 Retum ta Main Menu ] H
e v —

1 ZoomBrowser EX - C:\Documents and SettingsACanoniMy Documents

( 2. Select the save image type

N

\

STEP 2: Selectthe save image type

Save image type T S T

MatianIPE G (Y1) ~

Standard movie file used on computers.
[r'ou can set the image size, frame rate and image quality
in the next step.

- FRotation settings - _— _l

[ Holate
£ 80 degreas left
(O] QUd egrees Hght
(1180 degrees |

“3 Return to ain Menu
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Specify the export settings and click [Specify name of file to
be saved].

1 ZoomBrowser BX - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Tools Internst Help

ﬂnage Size \

Mo change
= ® a
() Zoom specification

) Size specification

Fist th

1. Select Movies

2. Select the save image type

e e

Set the save image type

—

if~\
A

o/

. Specify name of file to be saved

Frame Rate
Automatic w  Frames/second
5. Start export
Image Hualiy
-
L Standard High

Audio

- Avtornatic b
[ 3 Return to Main Menu ] \ )

Specify the file name and click [Start export].
In each case, specify the destination folder and file name of the movie to be
exported.

&1 ZoomBrowser EX - C:\Documents and SettingsiCanoniby Documents
File Edit View Tools Internet Help

‘ 1. Select Movies l File Marme zetting T e " S
(&) Same as original image
[ 2. Select the save image type ‘ Qe ot i
. abg e
3. Setthe save image twpe ‘M
OVIE
Specify name of file to be
saved
8. Start export ) - Save to folder
‘ C:ADocuments and SetingshCanoniMy Documents l Browse J
[Save image type information]
Save image type:Mationd PEG [4V1)
w = Image Size:Mo change
L”I Frame Fate:Automatic
Image Buali:s tandard
AudiocAutomatic
3 Retum to b ain Menu .

Destination Folder

Click [OK].

The Main Window appears.

MovieExport Task

Export is completed.

@ Details ==
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Extracting Still Images from Movies (Windows Vista/Windows XP)

You can extract still images from movies and save them as image files.

1 Click [Export] in the Main Window.

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniiy DocumentsiMy Pictures |:”E|E‘

Fil= Edit View Tools Internet  Help

[ Tasks

@ Acquire & Camera Settings

[?;‘" View & Classify
L@ Edit

Expart
@
l Internet

@ Slide Show @ search
Zoom Mode | Serall Mods: I Pr;ne_w_M;ﬂe,

by Fictures & ﬁ m 5 0 & |1|&l Ju:ﬂ ::'ﬂ Filter Taol

200_01_20

\\y/

é

£

IMG_0107.0PG  IMG_0108,PG

L L}

2 Click [Extract frames from a movie].

=1 ZoomBrowser EX - C:\Documents and SettingsiCanoniby DocumentsiMy Pictures

File Edit ‘iew Tools Internet Help

[ Tasks ?) e () e show @Saarth Deiere iR
l@ Edit
l@ Export

Export Still Images

»

ZoomMode | Serol Mode | Freview Mode |
Iy Fictures € + i @ -0 - | L3 G’l :l i J.ﬂ ,l,? Filter Tool

2006 01_20

Expart Movies

r| \[ . |

N L

Extract frames from a movie

Expart Shooting Properties

Expuort az a Screen Saver

Export as a '\ allpaper

Backup to CD

& e
@ Internet

- -
—— ]

e S

L L] Wl | |

=

3} 200%_01_

3 Select the movie from whlch you W|sh to extract still images
and click [Set extraction method].

1" ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy DocumentsiMy Pictures

Tools Inkermet  Help

Help

€ 4 [B1-0- (A& [ F Filer Toul

My Pictures

C 200<_07_20
3 Preview image

l 4. Setupsave

5. Perform processing

| 93 Retum to Main Menu
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4 Select the still images extraction method and click [Preview
image].

* [Extract all frames]: Extracts all frames in the movie as still images.

* [Specify an interval and extract frames]: Extracts frames as still images from a
specified frame range or time interval.

* [Specify the number of copies and extract frames]: Extracts a specified
number of still images from the entire movie. The extraction interval is
calculated based on an equal distribution of the specified number of still
images.

* [Extract a specified image]: Extracts still images from scenes that catch your
attention.

&7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniy Documents
Fil= Edit View Tools Internet  Help

File mame: Y01 06441
Play time: 00:07.00
Total frames: 105
Image Size: 320240

y
, Select how ta extract the still images from the movie \
() Extract all frames

4. Setupsave

l 5. Perform processing

Extracts every frame in the movie as a stil image.

() Specily an interval and extract frames

ey Specilies the interval at which stil images are extracted from the mavie,
e,
r‘a [ -
| T

rame

(7 Spexify the number of copies and extract frames
= Specifies the number of copies of still images to be extracted from the movie.

3 Retum to Main Menu Ui
-

() Extract a specified image
_—l o3 Extracts the frame pou select while watching a preview of the movie as a stil
=

H
Bl
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5 Confirm the still images which will be extracted (images with
check marks) and click [Set up save].
If you selected [Extract a specified image] in the previous window, the movie will

be displayed in the upper part of the window. Display the images you want and
click [Add].

&1 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

File Edit View Tools Internet Help

Help

File: marne: MW 07 06441
Play time: 00:07.00

Total frames: 105

Image Size:320:240

‘ 1. Select movie
l 2 Setextraction method

Preview image

~\ |

F||

L IN_ /. . .

Selup zave

8 Peiform processing

[ 3 Return to Main Menu ]

IZ% » : Rotates all still images.

o il i
A A - Clears or adds check marks to all still images at once.

il i, : Clears the check marks of all the still images before/after the
selected still images.

1 B2 : Changes the thumbnail size.

6 Specify the file name and the folder where you wish to save
it and click [Perform processing].

7 ZoomBrowser EX - C:ADocuments and Settings\Canoniy Doc uments.

File Edit Yiew Tools Internet Help

t:-'a Exdract frames from a movie STEP 4 Setup it Help
—

File Narme e
(&) se ariginal movie fil name

@ﬁg ) Specily a file name

1. Select movie

2 Set estraction mathod

3. Preview image

Save folder

) Save in same folder as original movie
Set up save .
a.\ . ) Specily the save folder
: Browse
| 5. Perform processing |

Auto folder creation
(=) dutomatically create a folder with the same name as the original movie

Qpe:lw folder name for auto crestion /

- <5 ave Contents>

3 Retum to Main Menu Saved images: 105

Image Size:320x240

Required disk space.Approx. 2.8MB

Save to folder. C:AD ocuments and Settingz\Canonsty Documentsh2000_01_20%4Y1_0106

il |

r|1
I\—,

.
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Saving on CD-R/RW Disks (Windows Vista/Windows XP)

You can copy and save images to CD-R or CD-RW disks. The shooting information is

copied along with the images.

(D)

as standard equipment.

This function can only be used on a computer that came with a CD-R/RW drive

1 Place a CD-R/RW disk in the computer’s CD-R/RW drive.

2 If the following window appears, click [Cancell].

3 Click [Export] in the Main Window.

#7 ZoomBrowser EX - C:ADocuments and Settings\Canonty Doc umentsity Pictures

CD Drive (F:)

windows can perform the same action each time you inzert
a dizk or connect a device with this kind of file:

(5] Blank CD
wihat do you want Wwindows to do®?

= e ) folde
i Lzsing ® il
S Take no action

[] Always do the selected action.

File Edit View Tools Internet  Help

[ Tasks @] -r__F':_-“ [z Prope; -7 Slide Shaw @ Search
@ Acquire & Camera Seftings Zoom Mode | Screll Made | Preview Mode|
My Pictures

L@

F@

Edit

|
J
)
Internet ] ‘

Export

6

Fritt

IMG_010LIPG  IMG_0102, PG
-
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4 Click [Backup to CD].

ZoomBrowser EX - C:\Documents and Settings\Canon\y DocumentsiMy Pictures

File Edit VYiew Tools Internet Help

[ Tasks Q|| (B8] ven mace Propeties @Shde Shaw @Sxaarch T e 3 Rotets
l@ Edit lﬁ' Zoam Mode | Seroll Mode | Preview Mode|
My Pictures € 3 @ -0 - |l|@l “ J-‘ ,],? Filter Taal
[@ Export
3} 200%_01_15

Expart Still Images

Export Movies

)

ME_001.0PG  TMG_0102,1PG

Expart Shooting Properties

l Extract frames from a movie
l Export as a Screen Saver

|
|
|
|
i
LEKDOH as 4 allpaper J

< IMG_0103.0PG  IMG_0104, PG

200%_0_20

5 Select the folders or images you wish to save and click
[Specify Backup Settings].

by Fictures

3] 200_m_15
3. Start Backup -

[ 9 Retumta Main Menu
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6 Set the backup settings and click [Start Backup].

The disk will be ejected from the drive when copying is complete.

=1 ZoomBrowser EX - C:\Documents and Settings\Canon'y Documents |l|li|\g‘
File Edit View Todls Internst Help

wpto CO

& 5
l 1. Select Images ] ( Backup Setings The speed atwhich your ‘

computer writes (burns) data to

L Specity Backup Settngs J Select CDA Ditve T the CD afects the CO iy

>~ ———— N, CD Title: In general, slower recording
[ 3. Start Backup ) = speeds create CDs that are less
- —_ = Speed Fastest b prane to errors.
[ Werity atter backup Itis akways a good idea to
choose “erity after backup'to
Use the Verify feature to test the data on the CO-R after backup is ensure that the backup was
complete. This will take longer. butwill determine whether the backup was successful
successiul.

Space on CD-R:

[ 1 Retmia bain e Usged 0.00 B, Current Seseion 122,81 KB, Remaining 702.70 ME

@ I

100 200 300 400 600 BO0

(1] Thefile sizes above are estimates only. The CO buming process
may not he completed if the remaining space is low.

o J

2% You can add images to a CD-R/RW disk that already contains images.
4
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Adding Still Images to the Memory Card in the
Camcorder

You can add still images (JPEG) from the computer to a memory card in the
camcorder.

70\ When using this function, you cannot add the still images to a memory card
\X¥] using a card reader/writer. Insert the card into the camcorder to add images.

B Adding Still Images to the Memory Card

1 Connect the camcorder to the computer ([1] 25).

2 Click the [Set to Camera] tab and click [Uploads images to
the camera).

¢ CameraWindow - Canon 4 %4 %

| Acquire Images | Print || Setto Camera |3emote shooting

Set My Camera

i ‘;J Confirms{changes camera settings

= :
uﬁl Uploads images to the camera

]

Dizplayz thiz screen when the camera iz connected

3 Select the still images you wish to save and click [Open].

Upload| Images from Disk

Loak in: : ) 200<_01_158

v 3 5 0 T o
E |
IMG_0103
3
Filename:  |*IMG_0102JPG" "IMG_0101.JPG"
Files of type: :“!.peg_[":P.g.:] v
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4 Select the image size and click [Add].
fdd image E|

Image will be added after zetup is performed.

(%) Add image as iz
(1 5end after changing the image to WG size (40480 dats)

Cancel

’0\ When you upload images edited with another application, image properties
\&¥] may be lost.
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| Using Various Functions

Attaching Still Images to E-mail Messages

You can attach selected still images to an e-mail message.

’0\ To use this function, the e-mail software must be enabled as MAPI client. For
\&¥] details, refer to the instruction manual of the e-mail software.

1 Click [Internet] in the Main Window.

#7 ZoomBrowser X - C:A\Documents and Settings\Canonikly Documents\Wy Pictures

File Edit Yiew Tooks Internet He\p

[ Tasks @
@ Acquirs & Camera Settings

=
[l;*ﬁ Wiew & Classify
I@ Edit

]

|

|
[ eo | 2l =~
&~ ] ﬁ o~

-
({j Iternet | MG_0101.0PG IMG_0102.JPG ‘
— |

Dp Slide Shows \Q Search

Zoom Mode | Sclo\IMode Preview Mode

¢ > 4 [H-0-] e [ P Ted ]|

5 200 _01_15

..

2 Click [Email Images].

#7 ZoomBrowser X - C:A\Documents and Settings\Canonidy Documents\My Pictures

File Edit View Tools Intermet Help

[ Tasks @ ] =} Bropetts @Shde Show @ Search E‘? Delete % Rat

@ Acquire & Camera Setings Zoom Mg ’:SC'UH Mode ” Preview Mode | — > = .
l = y Pictures ¢« T4 m-0- (RS ([ 5T Fiter Todl |
[r- 7 Wiew & Classify h kR -5 — |

B
i

l@ Export
l@ Frint
’ . Intemet

| Email Images

N\ /sl WL |

2
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Select the still images you wish to send and click [Change
Image Size].

&7 ZoomBrowser EX - C:\Documents and SettingsiCanoniiy DocumentsiMy Pictures |Z”E”z‘

File Edit View Tools Internet Help

g
i@‘ Ernail Images

Zoom Made | Seroll Mode Preview Mode
Select Images — T

= —— = Iy Pictures € 4+ HR-0- |l|'¢~'§ J,—-——""' ::Yﬂ Filter Tl
| 2. Change Image Size )
F——— | 3} 200%_01_15

3. SendorSave 7
l 4. Finigh l

I 2 Petumto Maineru | H IMG_D103.0PG  IMG_D104, G

Select image size and quality, and click [Send or Save].
If you wish to send the still image without changes, select [Send images
unchanged]. Normally select [Resize and compress images into JPEG type].
- [Long side/Short side]: Selects the long or short side and sets the image size
in numbers.
- [Quality]: Lowering this setting will lower image quality but reduce file size.
- You can check the compressed still image by pressing [Preview Images].
- Pressing [Calculate] displays the file size after the compression as [Modified
File Size].

#1 ZoomBrowser BX - C:\Documents and SettingsiCanoniy Doc uments

Tools Internet  Help

ou may wantto reduce the size

E ® Send images unchanged
) Resize and compress images into JFEG type
O Long side:
h = = .
: I #00 pixels
k
EI © Short side
=
[ e
el

Cluality: == Highest
'
Prewiew Images
Criginal File Size 28 KB
Modified File Size: 0.0 bytes

() “Whenthe image size is large, the images may not be sent property by
wour email program. A total size of 300KE is recommended

\_

ancl{or quality of the photos to &
total file size of less than 300KE
This insures that people can
receive yaur email

Decrease the file size ofthe
exported photas by reducing
the dirmensions. ZoomBrowser
EX maintains the photo's aspect
ratio during resizing.

You can also reduce the quality
ofthe photo. The image may not
Iook as sharp. but the file size
will be smaller.

High quality  Low quality
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5 Select to send still images by e-mail or to save the still

images in a folder and click [Finish].

* If you selected [Create a new email], your e-mail software starts and the
selected still images appear as an attachment in the message window. Input
address, subject and your comments and send the message. E-mail software
not supporting MAPI does not start automatically. In this case, select [Save the
images in a folder...].

« If you select [Save the images in a folder...], click [Browse] and select the
destination folder. Start your e-mail software and attach the saved still image
to a message.

&1 ZoomBrowser EX - C:\Documents and SettingsiCanonitMy Documents

it View Tools Internet Help

send later

Email Seftings Ifyour email program supports
MAPL you can attach the photos
© Create & new email directly fram ZoomBrowser EX

1. Select Images

l 2. Change Image Size

|
|
L Send or Save J

(1) This optionis only ava_\lable ifwou use an email program that Otherwiss, you nesd to save the
supponts MAPL. e.q. Microsoft Outlook Express.
photos in afolder. start your
email program, and then attach
) Sawve the images in afolderto send through an email program that does the pholos ta & new email
not support MaP!

Then:

1. Startyour preferred email grogram.
2. Aftach the images to an email as normal and send

I Return to Main Menu
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Running a Slide Show
You can view selected still images in a slide show.

1 Click [View & Classify] in the Main Window.

You can also view a slide show by clicking [Slide Show] on the Application Tool
Bar. Skip to step 4.

&7 ZoomBrowser EX. - C:ADocuments and SettingsiCanoniby DocumentsiMy Pictures |:|[EHZ‘
File Edit Wiew Tools Internst Help

[ Tazks 6 I e Irnage [@ Slide: Ehnw] Search

t@ Acquire & Camera Settings J Zoom Mode | Scioll Mode | F'rewew MDdE .
My Pictures € 4+ H-0- | k& [ Fite Too
r‘j iew & Clagsify

|
|

0

3] 20m<_p1_15

IMG_010L.PG  IMG_0102.PG
BT ==

2 Click [View as a Slide Show].

=7 ZoomBrowser % - C:ADocuments and SettingsiCanoniby DocumentsiMy Pictures |Z|[E|E‘

File Edit View Tools Internet Help

[ Tasks

@ Acquire & Camera Settings

@ Wiew & Classify

Wiew az a Slide Show

== @Shdashow @Saarch % Delete E& R.ot36e

ZoomMode | Seroll Mode | Preview Mode |

by Fictures € - ﬁ ||$' 0 = Q ‘ :L Juﬂ ::'ﬂ Filter Taol

3} 200%_01_15

&

7\l
_J.l_ d

Rename Multiple Files

Clazsify inta Falder

Search

iews Tools  Internet  Help

Zoom Mode ‘“SCIOH Mode | Preview Modéi

My Pictures € + B-0-| R‘ |& Jﬂ L7 Filter Tool
e

@ 200£_01_15

[ 3 Retum to Main Menu
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4 Select the slide show settings.

* [Image Size]: Select the size of the still images.

* [Image Information]: Select to show image information such as file name or
title.

 [Advance to Next Slide]: Select to advance manually or automatically. When
you select “Every 3 second(s)”, you can select the interval in the control below
(from 1 to 120 seconds).

* [Loop]: Select to stop the slide show after the last image or to continuously run
itin a loop.

* [Transitions]: Select the transition effect to be used when moving from one
slide to another. When you click an effect, you can check the effect in the
preview window.

1 ZoomBrowser B% - C:ADocuments and Settings\Canon\My Documents |'L||E|g‘
Fie Edit View Todls Internet Help

STEP 2: Slide Show Setup

de Show
1. Select Images ] f Slicle Show Settings \
o

Transi itions

[=1] 2 =)= |
=[] 4n]lne

3. Start Slide Show... ]

I

| t srmine: heir Image Size O Actual Size Elﬂ
e - © BestFit
| 9 Retun 1o Main Menu © Mesdmum Strstch
Image Infarmation: O Mo Information -
& Show Information
O Controls Only:

Advance to Next Slide: @ On clicking the left mouse buttan

O Ewvery 3 second(z)
lji
Y

B Click [Start Slide Show].

Click in the lower right corner to end the slide show.
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Adding Sound to a Still Image

* You can add a sound to an image. The sound file needs to be in WAVE type
(extension “.wav”) or in MIDI type (extension “.mid” or “.midi”).
* The sound cannot be played back on the camcorder.

1 In the Main Window, select an image and select [Add/
Remove Sound] from the [Edit] menu.

ale View  Tools  Internet  Help

Copy ChrlH-C
Copy ko Folder. ..
Miove bo Folder ...
Select all Chrl+a
Clear Selection Crrl+R

Rokate Image...
Rakake According o Ratation Information

Change Star Batine

i=
L)
L)
-
5
Al
=
=
|
U'

Edit Image. ..
L Manage My Camera...

2 Click [Add].

&= Sound

I_ OF. ] [ Caticel

3 Select the sound file and click [Open].
4 Ciick [OK].

» The sound file will be copied to the same folder as the image.
* To play back the sound, select an image with a sound icon and select [Play
Sound] from the [Edit] menu.

2Py © Toremove sound from an image, select [Remove] on the Sound window in
&7 step 2. ¥ disappears and the copied sound file will be deleted.
o The [Play Sound] window appears and plays back the sound.
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Reviewing and Changing the Owner Name of the
Camcorder

You can change and confirm the owner’s name of the camcorder.
1 Connect the camcorder to the computer ([ 25).

2 Click the [Set to Camera] tab and click [Confirms/changes
camera settings].

& CameraWindow - Canon 33 % %

Acquire Images | Print || Setto Camera |§3emate shooting

Set My Camera

Confirms/changes camera settings
= ,
_;@_-I Uploads images to the camera

[l

Dizplays this screen when the camera iz connected

3 Enter the camcorder’s owner’s name and click [OK].

#T Camera Settings

Carnera Model: Canan %k

Firnwuare YWerzion: 1.0.0.0

Owner's Mame:

Input the camcorder’s owner’s ————— Cann
[ Cancel ] [ Apply

name here (up to 31 characters).
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| Uninstalling the Software

Uninstall the software when you wish to delete it from your computer or when
reinstallation is required to fix corrupted files.

’0\ You must have authorization as a Computer System Administrator to uninstall
\&¥ programs.

Uninstalling ZoomBrowser EX

1 Click the Windows [start] menu and select [All Programs] »
[Canon Utilities] » [ZoomBrowser EX] and [ZoomBrowser
EX Uninstall].

5 Internet __J' My Documents
Internet Explorer
&3 E-mail L ‘A'.r‘ My Pictures =

3 Outlook Express @) Set Program Access and Defaults
A5 Windows Catalag

" MM Explorer & windows Update

® Windows Media Play ) Accessories 17 a
% Pi Canon Utlities 3 @ Camerawindow — »

R

'& windows Mavie Makell () Games vll & eos Uiy ,
; [ startup Pl ) MovieEd Task ¥

@ Tour Windows 5P 3

é Internet Explorer @ Ry 3

— 3 Msh Explorer
dﬁ ZoomBrowser EX ¥ P
@ Outlook Express

A ﬁ ZoamBrowser EX

sz ZoamBrowser EX Readme

r‘: Remote Assiskance ’g ZoomBrowser EX Uninstall
@ ‘Windows Media Player

allPrograms 3 Windows Messenger

!] Log G |(D | Turn OFF Computer

2%y © Other programs in the [Canon Utilities] folder can also be uninstalled in the
= same way.
O Uninstall all programs in [Canon Utilities] when you have uninstalled
ZoomBrowser EX.
o RAW Image Task is used with Canon digital camera. The camcorder does
not support the program, but you can uninstall the program in the same way
as uninstalling the ZoomBrowser EX.
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Uninstalling the TWAIN Driver (Windows 2000 only)

1 Connect the camcorder to the computer ([1] 25).

2 If a window for selecting an application program or the
Scanners and Cameras Wizard appears, click [Cancel]. If
ZoomBrowser EX started, close it.

3 Click the Windows [Start] menu and select [Settings] and
[Control Panel].

-

Double-click the [Scanners and Cameras] icon.

If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver
Uninstallation ([ 1] 87).

Delete [Canon Camera] from the [Scanners and Cameras
Properties] list.

Click [OK] to close the window.

Turn the camcorder POWER switch to OFF and remove the
USB cable from the computer.

0 ~NO& O

Click the Windows [Start] menu and select [Programs],
[Canon Utilities], [DV TWAIN Driver x.x] and [TWAIN Driver
Uninstall].

A version number appears in place of “x.x”".

9 When thé Confirm Uninsta" window appears,r crlick [OK].

The uninstall process starts.

10 When the Maintenance Complete window appears, click
[Finish].
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| Troubleshooting

Connection

Camcorder is not recognized when connected to the computer.

= Computer does not support the USB interface.
Refer to System Requirements ([ ] 5).

= There is no memory card in the camcorder.
Insert a memory card into the camcorder.

= The camcorder is not set to the correct mode.
Turn the POWER switch to ON and change the camcorder mode to PLAY by
sliding the POWER switch down. Move the '8 /¢y switch to €.

= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ([] 25) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in good
shape.

= If you are experiencing operational problems, detach the USB cable from
the camcorder and computer and terminate the connection. Restart the
computer and then reconnect the camcorder.

= TWAIN Driver is not installed properly.
First uninstall the TWAIN Driver, then reinstall the driver from the DIGITAL
VIDEO Solution Disk (remove the check marks from the other programs when
prompted to select the programs to be installed).

ZoomBrowser EX Operation

Cannot download still images.
= The camcorder is not set to the correct mode.
Turn the POWER switch to ON and change the camcorder mode to PLAY by
sliding the POWER switch down. Move the '™ /¢y switch to €.

Image files or folders do not appear in ZoomBrowser EX.
= Images or folders shown in ZoomBrowser EX and the actual file contents
may be different when an image file has been moved or copied using
Windows functions or edited with a separate program.
Click the [View] menu and select [Refresh Current Folder].

TWAIN Driver Installation ' Windows 2000

Cannot install the TWAIN Driver correctly.

= Does the system have a built-in USB port and did it come with Windows
2000 preinstalled? Refer to System Requirements ([ ] 5).

= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer (1] 25) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in good
shape.

= Are you using the power adapter to power the camcorder?

= If the problem is not mentioned above, the TWAIN Driver may not have
been recognized by Windows.
Uninstall and reinstall the driver.
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TWAIN Driver Uninstallation - Windows 2000

If you have problems when uninstalling the driver, use the following procedure to
remove it. Leave the camcorder connected to the computer.

’0\ The [Inf] folder contains numerous files that are critical to the computer’s
\&¥] operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.

Use the procedure below for the following circumstances too.
- If you do not find [Scanners and Cameras] in the [Control Panel] or
[Printers and Other Hardware].
- If [Canon Camera] or your camcorder model name does not appear in the
[Scanners and Cameras Properties] or [Scanners and Cameras].
- If you connected the camcorder to the computer via the USB cable before
installing the Digital Video Software.

Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [System] icon.
Click the [Hardware] tab.

Click the [Device Manager] button.

A b WON -

If [Canon Camera] or your camcorder model name appears
under the [Other Devices] and/or [Imaging Devices]
categories, use the following procedure to delete it.
1. Select [Canon Camera] or the name of the camcorder model, right-click the
mouse button and select [Delete].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.
Remove all copies of [Canon Camera] or your camcorder model name that
appear in the [Other Devices] or [Imaging Devices] categories, or that appear
more than once in one category.

6 Double-click the [My Computer] icon on the desktop,
followed by the [C:] drive, and the [Winnt] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder

Use the following procedure to show all files and folders.
1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Advanced setting] section, set the [Hidden files and folders] category
to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check mark.
4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.
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T Look for the file for Canon digital camcorders starting with
[Oem*].

* A number such as “0” or “1” will appear in place of the asterisk (*) above. You
will also find another file called [Oem*.pnf], which will have the same number
as the [Oem®.inf] file. The two constitute one set.

* There may be many file sets starting with “Oem”.

* If you double-click an [Oem*.inf] file, the Windows Notepad program will start
and show the file contents. Click each [Oem*inf] file until you find one that
contains “*** Canon Camera Driver Setup File*™*” in its first line. When you
find the correct file, note down its name and close the Notepad window.

8 Delete the [Oem*] file set.

Delete all [Oem*.inf] and [Oem*.pnf] files, taking great care to delete the correct
files.

If You Were Using ZoomBrowser EX Version 2 or 3
(This manual explains version 5.x)

Titles and comments added using a prior version than ZoomBrowser EX
version 4 do not appear in ZoomBrowser EX 4 or higher.
= Titles and comments added using a prior version of ZoomBrowser EX will
not be displayed. Use the following procedure to display them.

1. In Windows Explorer, open the [Program] folder under the folder in which you
installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program).

2. Double-click [dbconverter.exe].

3. Select the database you were using until now (C:\Program Files\Canon\
ZoomBrowser EX\Program) and click the [Start] button.

Note that with ZoomBrowser EX 4 or higher, both titles and comments appear
in the comment list.

Cannot find the image folders saved with a prior version than ZoomBrowser
EX 5.x.
= Image folders saved under the [Program Files] folder (such as [Image

Library One]) cannot be displayed in the Main Window’s Folder Area of

ZoomBrowser EX 4 or higher. Use the following procedure to display

them.

1. In Windows Explorer, open the [Program Files] folder under the folder in
which you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program\Image Library One).

2. Select the image folder you wish to display and copy the folder to a different
destination.
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